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1 Designing a Filter in Fdesign — Process Overview

Process Flow Diagram and Filter Design Methodology

In this section...

“Exploring the Process Flow Diagram” on page 1-2

“Selecting a Response” on page 1-4

“Selecting a Specification” on page 1-4

“Selecting an Algorithm” on page 1-6

“Customizing the Algorithm” on page 1-8

“Designing the Filter” on page 1-8

“Design Analysis” on page 1-9

“Realize or Apply the Filter to Input Data” on page 1-10

Note You must minimally have the Signal Processing Toolbox™ installed
to use fdesign and design. Some of the features described below may
be unavailable if your installation does not additionally include the Filter
Design Toolbox™ license. The Filter Design Toolbox significantly expands
the functionality available for the specification, design, and analysis of filters.
You can verify the presence of both toolboxes by typing ver at the command
prompt.

Exploring the Process Flow Diagram
The process flow diagram shown in the following figure lists the steps and
shows the order of the filter design process.
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Process Flow Diagram and Filter Design Methodology

The first four steps of the filter design process relate to the filter Specifications
Object, while the last two steps involve the filter Implementation Object. Both
of these objects are discussed in more detail in the following sections. Step 5
- the design of the filter, is the transition step from the filter Specifications
Object to the Implementation object. The analysis and verification step is
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1 Designing a Filter in Fdesign — Process Overview

completely optional. It provides methods for the filter designer to ensure that
the filter complies with all design criteria. Depending on the results of this
verification, you can loop back to steps 3 and 4, to either choose a different
algorithm, or to customize the current one. You may also wish to go back to
steps 3 or 4 after you filter the input data with the designed filter (step 7),
and find that you wish to tweak the filter or change it further.

The diagram shows the help command for each step. Enter the help line
at the MATLAB® command prompt to receive instructions and further
documentation links for the particular step. Not all of the steps have to be
executed explicitly. For example, you could go from step 1 directly to step 5,
and the interim three steps are done for you by the software.

The following are the details for each of the steps shown above.

Selecting a Response
If you type:

help fdesign/responses

at the MATLAB command prompt, you see a list of all available filter
responses. The responses marked with an asterisk require the Filter Design
Toolbox.

You must select a response to initiate the filter. In this example, a bandpass
filter Specifications Object is created by typing the following:

d = fdesign.bandpass

Selecting a Specification
A specification is an array of design parameters for a given filter. The
specification is a property of the Specifications Object.

Note A specification is not the same as the Specifications Object. A
Specifications Object contains a specification as one of its properties.

1-4



Process Flow Diagram and Filter Design Methodology

When you select a filter response, there are a number of different
specifications available. Each one contains a different combination of design
parameters. After you create a filter Specifications Object, you can query the
available specifications for that response. Specifications marked with an
asterisk require the Filter Design Toolbox.

>> d = fdesign.bandpass; % step 1 - choose the response
>> set (d, 'specification')

ans =

'Fst1,Fp1,Fp2,Fst2,Ast1,Ap,Ast2'
'N,F3dB1,F3dB2'
'N,F3dB1,F3dB2,Ap'
'N,F3dB1,F3dB2,Ast'
'N,F3dB1,F3dB2,Ast1,Ap,Ast2'
'N,F3dB1,F3dB2,BWp'
'N,F3dB1,F3dB2,BWst'
'N,Fc1,Fc2'
'N,Fp1,Fp2,Ap'
'N,Fp1,Fp2,Ast1,Ap,Ast2'
'N,Fst1,Fp1,Fp2,Fst2'
'N,Fst1,Fp1,Fp2,Fst2,Ap'
'N,Fst1,Fst2,Ast'
'Nb,Na,Fst1,Fp1,Fp2,Fst2'

>> d=fdesign.arbmag;
>> set(d,'specification')

ans =

'N,F,A'
'N,B,F,A'

The set command can be used to select one of the available specifications as
follows:

>> d = fdesign.lowpass; % step 1
>> % step 2: get a list of available specifications
>> set (d, 'specification')
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1 Designing a Filter in Fdesign — Process Overview

ans =

'Fp,Fst,Ap,Ast'
'N,F3dB'
'N,F3dB,Ap'
'N,F3dB,Ap,Ast'
'N,F3dB,Ast'
'N,F3dB,Fst'
'N,Fc'
'N,Fc,Ap,Ast'
'N,Fp,Ap'
'N,Fp,Ap,Ast'
'N,Fp,F3dB'
'N,Fp,Fst'
'N,Fp,Fst,Ap'
'N,Fp,Fst,Ast'
'N,Fst,Ap,Ast'
'N,Fst,Ast'
'Nb,Na,Fp,Fst'

>> %step 2: set the required specification
>> set (d, 'specification', 'N,Fc')

If you do not perform this step explicitly, fdesign returns the default
specification for the response you chose in “Selecting a Response” on page
1-4, and provides default values for all design parameters included in the
specification.

Selecting an Algorithm
The availability of algorithms depends the chosen filter response, the design
parameters, and the availability of the Filter Design Toolbox. In other words,
for the same lowpass filter, changing the specification string also changes the
available algorithms. In the following example, for a lowpass filter and a
specification of 'N, Fc', only one algorithm is available—window.

>> %step 2: set the required specification
>> set (d, 'specification', 'N,Fc')
>> designmethods (d) %step3: get available algorithms

1-6



Process Flow Diagram and Filter Design Methodology

Design Methods for class fdesign.lowpass (N,Fc):

window

However, for a specification of 'Fp,Fst,Ap,Ast', a number of algorithms are
available. If the user has only the Signal Processing Toolbox installed, the
following algorithms are available:

>>set (d, 'specification', 'Fp,Fst,Ap,Ast')
>>designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
cheby1
cheby2
ellip
equiripple
kaiserwin

If the user additionally has the Filter Design Toolbox installed, the number of
available algorithms for this response and specification string increases:

>>set(d,'specification','Fp,Fst,Ap,Ast')
>>designmethods(d)

Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):

butter
cheby1
cheby2
ellip
equiripple
ifir

1-7



1 Designing a Filter in Fdesign — Process Overview

kaiserwin
multistage

The user chooses a particular algorithm and implements the filter with the
design function.

>>Hd=design(d,'butter');

The preceding code actually creates the filter, where Hd is the filter
Implementation Object. This concept is discussed further in the next step.

If you do not perform this step explicitly, design automatically selects the
optimum algorithm for the chosen response and specification.

Customizing the Algorithm
The customization options available for any given algorithm depend not only
on the algorithm itself, selected in “Selecting an Algorithm” on page 1-6,
but also on the specification selected in “Selecting a Specification” on page
1-4. To explore all the available options, type the following at the MATLAB
command prompt:

help (d, 'algorithm-name')

where d is the Filter Specification Object, and algorithm-name is the name of
the algorithm in single quotes, such as 'butter' or 'cheby1'.

The application of these customization options takes place while “Designing
the Filter” on page 1-8, because these options are the properties of the filter
Implementation Object, not the Specification Object.

If you do not perform this step explicitly, the optimum algorithm structure is
selected.

Designing the Filter
This next task introduces a new object, the Filter Object, or dfilt. To create
a filter, use the design command:

>> % design filter w/o specifying the algorithm
>> Hd = design(d);

1-8



Process Flow Diagram and Filter Design Methodology

where Hd is the Filter Object and d is the Specifications Object. This code
creates a filter without specifying the algorithm. When the algorithm is not
specified, the software selects the best available one.

To apply the algorithm chosen in “Selecting an Algorithm” on page 1-6, use
the same design command, but specify the Butterworth algorithm as follows:

>> Hd = design(d, 'butter');

where Hd is the new Filter Object, and d is the Specifications Object.

To obtain help and see all the available options, type:

>> help fdesign/design

This help command describes not only the options for the design command
itself, but also options that pertain to the method or the algorithm. If you
are customizing the algorithm, you apply these options in this step. In the
following example, you design a bandpass filter, and then modify the filter
structure:

>> Hd = design(d, 'butter', 'filterstructure', 'df2sos')

f =

FilterStructure: 'Direct-Form II, Second-Order Sections'
Arithmetic: 'double'
sosMatrix: [7x6 double]

ScaleValues: [8x1 double]
PersistentMemory: false

The filter design step, just like the first task of choosing a response, must be
performed explicitly. A Filter Object is created only when design is called.

Design Analysis
After the filter is designed you may wish to analyze it to determine if the filter
satisfies the design criteria. Filter analysis is broken into three main sections:

• Frequency domain analysis — Includes the magnitude response, group
delay, and pole-zero plots.
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• Time domain analysis — Includes impulse and step response

• Implementation analysis — Includes quantization noise and cost

To display help for analysis of a discrete-time filter, type:

>> help dfilt/analysis

To display help for analysis of a multirate filter, type:

>> help mfilt/functions

To display help for analysis of a farrow filter, type:

>> help farrow/functions

To analyze your filter, you must explicitly perform this step.

Realize or Apply the Filter to Input Data
After the filter is designed and optimized, it can be used to filter actual input
data. The basic filter command takes input data x, filters it through the Filter
Object, and produces output y:

>> y = filter (FilterObj, x)

This step is never automatically performed for you. To filter your data, you
must explicitly execute this step. To understand how the filtering commands
work, type:

>> help dfilt/filter

Note If you have Simulink®, you have the option of exporting this filter
to a Simulink block using the realizemdl command. To get help on this
command, type:

>> help realizemdl
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2 Designing a Filter in the Filterbuilder GUI

The Graphical Interface to Fdesign

In this section...

“Introduction to Filterbuilder” on page 2-2

“Filterbuilder Design Process” on page 2-2

“Select a Response” on page 2-3

“Select a Specification” on page 2-6

“Select an Algorithm” on page 2-6

“Customize the Algorithm” on page 2-7

“Analyze the Design” on page 2-9

“Realize or Apply the Filter to Input Data” on page 2-9

Introduction to Filterbuilder
The filterbuilder function provides a graphical interface to the
fdesign object-oriented filter design paradigm and is intended to reduce
development time during the filter design process. filterbuilder uses a
specification-centered approach to find the best filter for the desired response.

Note filterbuilder requires the Signal Processing Toolbox. The
functionality of filterbuilder is greatly expanded by the Filter Design
Toolbox. Some of the features described or displayed below are only available
if the Filter Design Toolbox is installed. You may verify your installation by
typing ver at the command prompt.

Filterbuilder Design Process
The design process when using filterbuilder is similar to the process
outlined in the section titled “Designing a Filter in Fdesign — Process
Overview” in the Getting Started guide. The idea is to choose the constraints
and specifications of the filter, and to use those as a starting point in the
design. Postponing the choice of algorithm for the filter allows the best design
method to be determined automatically, based upon the desired performance
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criteria. The following are the details of each of the steps for designing a
filter with filterbuilder.

Select a Response
When you open the filterbuilder tool by typing:

filterbuilder

at the MATLAB command prompt, the Response Selection dialog box
appears, listing all possible filter responses available in the software. If you
have the Filter Design Toolbox software installed, you have access to the
full complement of filter responses and the Response Selection dialog box
appears as follows:

Note This step cannot be skipped because it is not automatically completed
for you by the software. You must select a response to initiate the filter design
process.

After you choose a response, say bandpass, you start the design of the
Specifications Object, and the Bandpass Design dialog box appears.
This dialog box contains a Main pane, a Data Types pane and a Code
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Generation pane. The specifications of your filter are generally set in the
Main pane of the dialog box.

The Data Types pane provides settings for precision and data types, and the
Code Generation pane contains options for various implementations of
the completed filter design.

For the initial design of your filter, you will mostly use theMain pane.
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The Bandpass Design dialog box contains all the parameters you need to
determine the specifications of a bandpass filter. The parameters listed in
the Main pane depend upon the type of filter you are designing. However,
no matter what type of filter you have chosen in the Response Selection
dialog box, the filter design dialog box contains the Main, Data Types, and
Code Generation panes.
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Select a Specification
To choose the specification for the bandpass filter, you can begin by selecting
an Impulse Response, Order Mode, and Filter Type in the Filter
Specifications frame of the Main Pane. You can further specify the
response of your filter by setting frequency and magnitude specifications in
the appropriate frames on the Main Pane.

Note Frequency, Magnitude, and Algorithm specifications are
interdependent and may change based upon your Filter Specifications
selections. When choosing specifications for your filter, select your Filter
Specifications first and work your way down the dialog box- this approach
ensures that the best settings for dependent specifications display as available
in the dialog box.

Select an Algorithm
The algorithms available for your filter depend upon the filter response and
design parameters you have selected in the previous steps. For example, in the
case of a bandpass filter, if the impulse response selected is IIR and the Order
Mode field is set toMinimum, the design methods available is Butterworth,
Chebyshev type I or II, or Elliptic, whereas if the Order Mode field is set
to Specify, the design method available is IIR least p-norm.
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Customize the Algorithm
By expanding the Design options section of the Algorithm frame, you
can further customize the algorithm specified. The options available will
depend upon the algorithm and settings that have already been selected in
the dialog box. In the case of a bandpass IIR filter using the Butterworth
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method, design options such as Match Exactly are available, as shown in
the following figure.
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Analyze the Design
To analyze the filter response, click on the View Filter Response button. The
Filter Visualization Tool opens displaying the magnitude plot of the filter
response.

Realize or Apply the Filter to Input Data
When you have achieved the desired filter response through design iterations
and analysis using the Filter Visualization Tool, apply the filter to the
input data. Again, this step is never automatically performed for you by the
software. To filter your data, you must explicitly execute this step. In the
Filter Visualization Tool, click OK and Filter Design Toolbox software
creates the filter object with the name specified in the Save variable as field
and exports it to the MATLAB workspace.

The filter is then ready to be used to filter actual input data. The basic filter
command takes input data x, filters it through the Filter Object, and produces
output y:

>> y = filter (FilterObj, x)

To understand how the filtering commands work, type:

>> help dfilt/filter
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Tip If you have Simulink, you have the option of exporting this filter to
a Simulink block using the realizemdl command. To get help on this
command, type:

>> help realizemdl
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Designing a FIR Filter Using filterbuilder

FIR Filter Design

Example – Using Filterbuilder to Design a Finite Impulse Response
(FIR) Filter
To design a lowpass FIR filter using filterbuilder:

1 Open the Filterbuilder GUI by typing the following at the MATLAB prompt:

filterbuilder

The Response Selection dialog box appears. In this dialog box, you can
select from a list of filter response types. Select Lowpass in the list box.

2 Hit the OK button. The Lowpass Design dialog box opens. Here you
can specify the writable parameters of the Lowpass filter object. The
components of the Main frame of this dialog box are described in the
section titled Lowpass Filter Design Dialog Box — Main Pane. In the dialog
box, make the following changes:

• Enter a Fpass value of 0.55.

• Enter a Fstop value of 0.65.
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3 Click Apply, and the following message appears at the MATLAB prompt:

The variable 'Hlp' has been exported to the command window.
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4 To check your design, click View Filter Response. The Filter
Visualization tool appears, showing a plot of the magnitude response of
the filter.

You can change the design and click Apply, followed by View Filter
Response, as many times as needed until your design specifications are
met.
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3 Digital Frequency Transformations

Details and Methodology

In this section...

“Overview of Transformations” on page 3-2

“Selecting Features Subject to Transformation” on page 3-6

“Mapping from Prototype Filter to Target Filter” on page 3-8

“Summary of Frequency Transformations” on page 3-10

Overview of Transformations
Converting existing FIR or IIR filter designs to a modified IIR form is often
done using allpass frequency transformations. Although the resulting designs
can be considerably more expensive in terms of dimensionality than the
prototype (original) filter, their ease of use in fixed or variable applications is
a big advantage.

The general idea of the frequency transformation is to take an existing
prototype filter and produce another filter from it that retains some of the
characteristics of the prototype, in the frequency domain. Transformation
functions achieve this by replacing each delaying element of the prototype
filter with an allpass filter carefully designed to have a prescribed phase
characteristic for achieving the modifications requested by the designer.

The basic form of mapping commonly used is

The HA(z) is an Nth-order allpass mapping filter given by
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where

Ho(z) — Transfer function of the prototype filter

HA(z)— Transfer function of the allpass mapping filter

HT(z) — Transfer function of the target filter

Let’s look at a simple example of the transformation given by

The target filter has its poles and zeroes flipped across the origin of the real
and imaginary axes. For the real filter prototype, it gives a mirror effect
against 0.5, which means that lowpass Ho(z) gives rise to a real highpass
HT(z). This is shown in the following figure for the prototype filter designed
as a third-order halfband elliptic filter.
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Example of a Simple Mirror Transformation

The choice of an allpass filter to provide the frequency mapping is necessary
to provide the frequency translation of the prototype filter frequency response
to the target filter by changing the frequency position of the features from the
prototype filter without affecting the overall shape of the filter response.

The phase response of the mapping filter normalized to π can be interpreted
as a translation function:

The graphical interpretation of the frequency transformation is shown in the
figure below. The complex multiband transformation takes a real lowpass
filter and converts it into a number of passbands around the unit circle.
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Graphical Interpretation of the Mapping Process

Most of the frequency transformations are based on the second-order allpass
mapping filter:

The two degrees of freedom provided by α1 and α2 choices are not fully used
by the usual restrictive set of “flat-top” classical mappings like lowpass to
bandpass. Instead, any two transfer function features can be migrated to
(almost) any two other frequency locations if α1 and α2 are chosen so as to keep
the poles of HA(z) strictly outside the unit circle (since HA(z) is substituted
for z in the prototype transfer function). Moreover, as first pointed out
by Constantinides, the selection of the outside sign influences whether the
original feature at zero can be moved (the minus sign, a condition known
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as “DC mobility”) or whether the Nyquist frequency can be migrated (the
“Nyquist mobility” case arising when the leading sign is positive).

All the transformations forming the package are explained in the next
sections of the tutorial. They are separated into those operating on real
filters and those generating or working with complex filters. The choice of
transformation ranges from standard Constantinides first and second-order
ones [1][2] up to the real multiband filter by Mullis and Franchitti [3], and
the complex multiband filter and real/complex multipoint ones by Krukowski,
Cain and Kale [4].

Selecting Features Subject to Transformation
Choosing the appropriate frequency transformation for achieving the required
effect and the correct features of the prototype filter is very important
and needs careful consideration. It is not advisable to use a first-order
transformation for controlling more than one feature. The mapping filter
will not give enough flexibility. It is also not good to use higher order
transformation just to change the cutoff frequency of the lowpass filter. The
increase of the filter order would be too big, without considering the additional
replica of the prototype filter that may be created in undesired places.

Feature Selection for Real Lowpass to Bandpass Transformation
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To illustrate the idea, the second-order real multipoint transformation was
applied three times to the same elliptic halfband filter in order to make it
into a bandpass filter. In each of the three cases, two different features of
the prototype filter were selected in order to obtain a bandpass filter with
passband ranging from 0.25 to 0.75. The position of the DC feature was not
important, but it would be advantageous if it were in the middle between
the edges of the passband in the target filter. In the first case the selected
features were the left and the right band edges of the lowpass filter passband,
in the second case they were the left band edge and the DC, in the third case
they were DC and the right band edge.
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Result of Choosing Different Features

The results of all three approaches are completely different. For each of them
only the selected features were positioned precisely where they were required.
In the first case the DC is moved toward the left passband edge just like all
the other features close to the left edge being squeezed there. In the second
case the right passband edge was pushed way out of the expected target as
the precise position of DC was required. In the third case the left passband
edge was pulled toward the DC in order to position it at the correct frequency.
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The conclusion is that if only the DC can be anywhere in the passband, the
edges of the passband should have been selected for the transformation. For
most of the cases requiring the positioning of passbands and stopbands,
designers should always choose the position of the edges of the prototype
filter in order to make sure that they get the edges of the target filter in the
correct places. Frequency responses for the three cases considered are shown
in the figure. The prototype filter was a third-order elliptic lowpass filter
with cutoff frequency at 0.5.

The MATLAB code used to generate the figure is given here.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

In the example the requirements are set to create a real bandpass filter
with passband edges at 0.1 and 0.3 out of the real lowpass filter having the
cutoff frequency at 0.5. This is attempted in three different ways. In the first
approach both edges of the passband are selected, in the second approach the
left edge of the passband and the DC are chosen, while in the third approach
the DC and the right edge of the passband are taken:

[num1,den1] = iirlp2xn(b, a, [-0.5, 0.5], [0.1, 0.3]);
[num2,den2] = iirlp2xn(b, a, [-0.5, 0.0], [0.1, 0.2]);
[num3,den3] = iirlp2xn(b, a, [ 0.0, 0.5], [0.2, 0.3]);

Mapping from Prototype Filter to Target Filter
In general the frequency mapping converts the prototype filter, Ho(z), to the
target filter, HT(z), using the NAth-order allpass filter, HA(z). The general
form of the allpass mapping filter is given in “Overview of Transformations”
on page 3-2. The frequency mapping is a mathematical operation that
replaces each delayer of the prototype filter with an allpass filter. There
are two ways of performing such mapping. The choice of the approach is
dependent on how prototype and target filters are represented.

When the Nth-order prototype filter is given with pole-zero form
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the mapping will replace each pole, pi, and each zero, zi, with a number of
poles and zeros equal to the order of the allpass mapping filter:

The root finding needs to be used on the bracketed expressions in order to find
the poles and zeros of the target filter.

When the prototype filter is described in the numerator-denominator form:

Then the mapping process will require a number of convolutions in order to
calculate the numerator and denominator of the target filter:

For each coefficient αi and βi of the prototype filter the NAth-order polynomials
must be convolved N times. Such approach may cause rounding errors for
large prototype filters and/or high order mapping filters. In such a case the
user should consider the alternative of doing the mapping using via poles
and zeros.
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Summary of Frequency Transformations

Advantages

• Most frequency transformations are described by closed-form solutions or
can be calculated from the set of linear equations.

• They give predictable and familiar results.

• Ripple heights from the prototype filter are preserved in the target filter.

• They are architecturally appealing for variable and adaptive filters.

Disadvantages

• There are cases when using optimization methods to design the required
filter gives better results.

• High-order transformations increase the dimensionality of the target filter,
which may give expensive final results.

• Starting from fresh designs helps avoid locked-in compromises.
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Frequency Transformations for Real Filters

In this section...

“Overview” on page 3-11

“Real Frequency Shift” on page 3-11

“Real Lowpass to Real Lowpass” on page 3-13

“Real Lowpass to Real Highpass” on page 3-15

“Real Lowpass to Real Bandpass” on page 3-17

“Real Lowpass to Real Bandstop” on page 3-19

“Real Lowpass to Real Multiband” on page 3-21

“Real Lowpass to Real Multipoint” on page 3-23

Overview
This section discusses real frequency transformations that take the real
lowpass prototype filter and convert it into a different real target filter. The
target filter has its frequency response modified in respect to the frequency
response of the prototype filter according to the characteristic of the applied
frequency transformation.

Real Frequency Shift
Real frequency shift transformation uses a second-order allpass mapping
filter. It performs an exact mapping of one selected feature of the frequency
response into its new location, additionally moving both the Nyquist and DC
features. This effectively moves the whole response of the lowpass filter by
the distance specified by the selection of the feature from the prototype filter
and the target filter. As a real transformation, it works in a similar way
for positive and negative frequencies.

with α given by
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where

ωold — Frequency location of the selected feature in the prototype filter

ωnew — Position of the feature originally at ωold in the target filter

The following example shows how this transformation can be used to move
the response of the prototype lowpass filter in either direction. Please note
that because the target filter must also be real, the response of the target
filter will inherently be disturbed at frequencies close to Nyquist and close to
DC. Here is the MATLAB code for generating the example in the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation moves the feature originally at 0.5 to 0.9:

[num,den] = iirshift(b, a, 0.5, 0.9);
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Example of Real Frequency Shift Mapping

Real Lowpass to Real Lowpass
Real lowpass filter to real lowpass filter transformation uses a first-order
allpass mapping filter. It performs an exact mapping of one feature of the
frequency response into the new location keeping DC and Nyquist features
fixed. As a real transformation, it works in a similar way for positive and
negative frequencies. It is important to mention that using first-order
mapping ensures that the order of the filter after the transformation is the
same as it was originally.

with α given by
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where

ωold — Frequency location of the selected feature in the prototype filter

ωnew — Frequency location of the same feature in the target filter

The example below shows how to modify the cutoff frequency of the prototype
filter. The MATLAB code for this example is shown in the following figure.

The prototype filter is a halfband elliptic, real, third-order filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The cutoff frequency moves from 0.5 to 0.75:

[num,den] = iirlp2lp(b, a, 0.5, 0.75);
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Example of Real Lowpass to Real Lowpass Mapping

Real Lowpass to Real Highpass
Real lowpass filter to real highpass filter transformation uses a first-order
allpass mapping filter. It performs an exact mapping of one feature of the
frequency response into the new location additionally swapping DC and
Nyquist features. As a real transformation, it works in a similar way for
positive and negative frequencies. Just like in the previous transformation
because of using a first-order mapping, the order of the filter before and after
the transformation is the same.

with α given by

3-15



3 Digital Frequency Transformations

where

ωold — Frequency location of the selected feature in the prototype filter

ωnew — Frequency location of the same feature in the target filter

The example below shows how to convert the lowpass filter into a highpass
filter with arbitrarily chosen cutoff frequency. In the MATLAB code below,
the lowpass filter is converted into a highpass with cutoff frequency shifted
from 0.5 to 0.75. Results are shown in the figure.

The prototype filter is a halfband elliptic, real, third-order filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example moves the cutoff frequency from 0.5 to 0.75:

[num,den] = iirlp2hp(b, a, 0.5, 0.75);
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Example of Real Lowpass to Real Highpass Mapping

Real Lowpass to Real Bandpass
Real lowpass filter to real bandpass filter transformation uses a second-order
allpass mapping filter. It performs an exact mapping of two features of the
frequency response into their new location additionally moving a DC feature
and keeping the Nyquist feature fixed. As a real transformation, it works in a
similar way for positive and negative frequencies.

with α and β given by
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where

ωold — Frequency location of the selected feature in the prototype filter

ωnew,1 — Position of the feature originally at (-ωold) in the target filter

ωnew,2 — Position of the feature originally at (+ωold) in the target filter

The example below shows how to move the response of the prototype lowpass
filter in either direction. Please note that because the target filter must
also be real, the response of the target filter will inherently be disturbed at
frequencies close to Nyquist and close to DC. Here is the MATLAB code for
generating the example in the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates the passband between 0.5 and 0.75:

[num,den] = iirlp2bp(b, a, 0.5, [0.5, 0.75]);
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Example of Real Lowpass to Real Bandpass Mapping

Real Lowpass to Real Bandstop
Real lowpass filter to real bandstop filter transformation uses a second-order
allpass mapping filter. It performs an exact mapping of two features of
the frequency response into their new location additionally moving a
Nyquist feature and keeping the DC feature fixed. This effectively creates
a stopband between the selected frequency locations in the target filter. As
a real transformation, it works in a similar way for positive and negative
frequencies.

with α and β given by
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where

ωold — Frequency location of the selected feature in the prototype filter

ωnew,1 — Position of the feature originally at (-ωold) in the target filter

ωnew,2 — Position of the feature originally at (+ωold) in the target filter

The following example shows how this transformation can be used to convert
the prototype lowpass filter with cutoff frequency at 0.5 into a real bandstop
filter with the same passband and stopband ripple structure and stopband
positioned between 0.5 and 0.75. Here is the MATLAB code for generating the
example in the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates a stopband from 0.5 to 0.75:

[num,den] = iirlp2bs(b, a, 0.5, [0.5, 0.75]);
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Example of Real Lowpass to Real Bandstop Mapping

Real Lowpass to Real Multiband
This high-order transformation performs an exact mapping of one selected
feature of the prototype filter frequency response into a number of new
locations in the target filter. Its most common use is to convert a real lowpass
with predefined passband and stopband ripples into a real multiband filter
with N arbitrary band edges, where N is the order of the allpass mapping filter.

The coefficients α are given by
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where

ωold,k— Frequency location of the first feature in the prototype filter

ωnew,k— Position of the feature originally at ωold,k in the target filter

The mobility factor, S, specifies the mobility or either DC or Nyquist feature:

The example below shows how this transformation can be used to convert the
prototype lowpass filter with cutoff frequency at 0.5 into a filter having a
number of bands positioned at arbitrary edge frequencies 1/5, 2/5, 3/5 and 4/5.
Parameter S was such that there is a passband at DC. Here is the MATLAB
code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates three stopbands, from DC to 0.2, from
0.4 to 0.6 and from 0.8 to Nyquist:

[num,den] = iirlp2mb(b, a, 0.5, [0.2, 0.4, 0.6, 0.8], `pass');
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Example of Real Lowpass to Real Multiband Mapping

Real Lowpass to Real Multipoint
This high-order frequency transformation performs an exact mapping of a
number of selected features of the prototype filter frequency response to their
new locations in the target filter. The mapping filter is given by the general
IIR polynomial form of the transfer function as given below.

For the Nth-order multipoint frequency transformation the coefficients α are
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where

ωold,k— Frequency location of the first feature in the prototype filter

ωnew,k— Position of the feature originally at ωold,k in the target filter

The mobility factor, S, specifies the mobility of either DC or Nyquist feature:

The example below shows how this transformation can be used to move
features of the prototype lowpass filter originally at -0.5 and 0.5 to their new
locations at 0.5 and 0.75, effectively changing a position of the filter passband.
Here is the MATLAB code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates a passband from 0.5 to 0.75:

[num,den] = iirlp2xn(b, a, [-0.5, 0.5], [0.5, 0.75], `pass');
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Frequency Transformations for Complex Filters

In this section...

“Overview” on page 3-26

“Complex Frequency Shift” on page 3-26

“Real Lowpass to Complex Bandpass” on page 3-28

“Real Lowpass to Complex Bandstop” on page 3-30

“Real Lowpass to Complex Multiband” on page 3-32

“Real Lowpass to Complex Multipoint” on page 3-34

“Complex Bandpass to Complex Bandpass” on page 3-36

Overview
This section discusses complex frequency transformation that take the
complex prototype filter and convert it into a different complex target
filter. The target filter has its frequency response modified in respect to the
frequency response of the prototype filter according to the characteristic of the
applied frequency transformation from:

Complex Frequency Shift
Complex frequency shift transformation is the simplest first-order
transformation that performs an exact mapping of one selected feature of the
frequency response into its new location. At the same time it rotates the
whole response of the prototype lowpass filter by the distance specified by the
selection of the feature from the prototype filter and the target filter.

with α given by

where
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ωold— Frequency location of the selected feature in the prototype filter

ωnew— Position of the feature originally at ωold in the target filter

A special case of the complex frequency shift is a, so called, Hilbert
Transformer. It can be designed by setting the parameter to |α|=1, that is

The example below shows how to apply this transformation to rotate the
response of the prototype lowpass filter in either direction. Please note that
because the transformation can be achieved by a simple phase shift operator,
all features of the prototype filter will be moved by the same amount. Here is
the MATLAB code for generating the example in the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation moves the feature originally at 0.5 to 0.3:

[num,den] = iirshiftc(b, a, 0.5, 0.3);
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Example of Complex Frequency Shift Mapping

Real Lowpass to Complex Bandpass
This first-order transformation performs an exact mapping of one selected
feature of the prototype filter frequency response into two new locations in
the target filter creating a passband between them. Both Nyquist and DC
features can be moved with the rest of the frequency response.

with α and β are given by
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where

ωold— Frequency location of the selected feature in the prototype filter

ωnew,1— Position of the feature originally at (-ωold) in the target filter

ωnew,2— Position of the feature originally at (+ωold) in the target filter

The following example shows the use of such a transformation for converting
a real halfband lowpass filter into a complex bandpass filter with band edges
at 0.5 and 0.75. Here is the MATLAB code for generating the example in
the figure.

The prototype filter is a half band elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The transformation creates a passband from 0.5 to 0.75:

[num,den] = iirlp2bpc(b, a, 0.5, [0.5 0.75]);
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Example of Real Lowpass to Complex Bandpass Mapping

Real Lowpass to Complex Bandstop
This first-order transformation performs an exact mapping of one selected
feature of the prototype filter frequency response into two new locations in
the target filter creating a stopband between them. Both Nyquist and DC
features can be moved with the rest of the frequency response.

with α and β are given by
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where

ωold— Frequency location of the selected feature in the prototype filter

ωnew,1— Position of the feature originally at (-ωold) in the target filter

ωnew,2— Position of the feature originally at (+ωold) in the target filter

The example below shows the use of such a transformation for converting a
real halfband lowpass filter into a complex bandstop filter with band edges
at 0.5 and 0.75. Here is the MATLAB code for generating the example in
the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The transformation creates a stopband from 0.5 to 0.75:

[num,den] = iirlp2bsc(b, a, 0.5, [0.5 0.75]);
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Example of Real Lowpass to Complex Bandstop Mapping

Real Lowpass to Complex Multiband
This high-order transformation performs an exact mapping of one selected
feature of the prototype filter frequency response into a number of new
locations in the target filter. Its most common use is to convert a real lowpass
with predefined passband and stopband ripples into a multiband filter
with arbitrary band edges. The order of the mapping filter must be even,
which corresponds to an even number of band edges in the target filter. The
Nth-order complex allpass mapping filter is given by the following general
transfer function form:
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The coefficients α are calculated from the system of linear equations:

where

ωold— Frequency location of the selected feature in the prototype filter

ωnew,i— Position of features originally at ±ωold in the target filter

Parameter S is the additional rotation factor by the frequency distance ΔC,
giving the additional flexibility of achieving the required mapping:

The example shows the use of such a transformation for converting a prototype
real lowpass filter with the cutoff frequency at 0.5 into a multiband complex
filter with band edges at 0.2, 0.4, 0.6 and 0.8, creating two passbands around
the unit circle. Here is the MATLAB code for generating the figure.
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Example of Real Lowpass to Complex Multiband Mapping

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates two complex passbands:

[num,den] = iirlp2mbc(b, a, 0.5, [0.2, 0.4, 0.6, 0.8]);

Real Lowpass to Complex Multipoint
This high-order transformation performs an exact mapping of a number
of selected features of the prototype filter frequency response to their new
locations in the target filter. The Nth-order complex allpass mapping filter is
given by the following general transfer function form.
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The coefficients α can be calculated from the system of linear equations:

where

ωold,k— Frequency location of the first feature in the prototype filter

ωnew,k— Position of the feature originally at ωold,k in the target filter

Parameter S is the additional rotation factor by the frequency distance ΔC,
giving the additional flexibility of achieving the required mapping:

The following example shows how this transformation can be used to move
one selected feature of the prototype lowpass filter originally at -0.5 to two
new frequencies -0.5 and 0.1, and the second feature of the prototype filter
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from 0.5 to new locations at -0.25 and 0.3. This creates two nonsymmetric
passbands around the unit circle, creating a complex filter. Here is the
MATLAB code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates two nonsymmetric passbands:

[num,den] = iirlp2xc(b,a,0.5*[-1,1,-1,1], [-0.5,-0.25,0.1,0.3]);
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Example of Real Lowpass to Complex Multipoint Mapping

Complex Bandpass to Complex Bandpass
This first-order transformation performs an exact mapping of two selected
features of the prototype filter frequency response into two new locations in
the target filter. Its most common use is to adjust the edges of the complex
bandpass filter.
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with α and β are given by

where

ωold,1— Frequency location of the first feature in the prototype filter

ωold,2— Frequency location of the second feature in the prototype filter

ωnew,1— Position of the feature originally at ωold,1 in the target filter

ωnew,2— Position of the feature originally at ωold,2 in the target filter

The following example shows how this transformation can be used to modify
the position of the passband of the prototype filter, either real or complex. In
the example below the prototype filter passband spanned from 0.5 to 0.75.
It was converted to having a passband between -0.5 and 0.1. Here is the
MATLAB code for generating the figure.

The prototype filter is a halfband elliptic, real, third-order lowpass filter:

[b, a] = ellip(3, 0.1, 30, 0.409);

The example transformation creates a passband from 0.25 to 0.75:

[num,den] = iirbpc2bpc(b, a, [0.25, 0.75], [-0.5, 0.1]);
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Designing Advanced Filters in FDATool

In this section...

“Overview of FDATool Features” on page 4-2

“Using FDATool with Filter Design Toolbox Software” on page 4-3

“Example — Design a Notch Filter” on page 4-3

Overview of FDATool Features
Filter Design Toolbox software adds new dialog boxes and operating modes,
and new menu selections, to the Filter Design and Analysis Tool (FDATool)
provided by Signal Processing Toolbox software. From the new dialog boxes,
one titled Set Quantization Parameters and one titled Frequency
Transformations, you can:

• Design advanced filters that Signal Processing Toolbox software does not
provide the design tools to develop.

• View Simulink models of the filter structures available in the toolbox.

• Quantize double-precision filters you design in this GUI using the design
mode.

• Quantize double-precision filters you import into this GUI using the import
mode.

• Analyze quantized filters.

• Scale second-order section filters.

• Select the quantization settings for the properties of the quantized filter
displayed by the tool:

- Coefficients — select the quantization options applied to the filter
coefficients

- Input/output — control how the filter processes input and output data

- Filter Internals — specify how the arithmetic for the filter behaves

• Design multirate filters.

• Transform both FIR and IIR filters from one response to another.
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After you import a filter in to FDATool, the options on the quantization
dialog box let you quantize the filter and investigate the effects of various
quantization settings.

Options in the frequency transformations dialog box let you change the
frequency response of your filter, keeping various important features while
changing the response shape.

Using FDATool with Filter Design Toolbox Software
Adding Filter Design Toolbox software to your tool suite adds a number of
filter design techniques to FDATool. Use the new filter responses to develop
filters that meet more complex requirements than those you can design
in Signal Processing Toolbox software. While the designs in FDATool are
available as command line functions, the graphical user interface of FDATool
makes the design process more clear and easier to accomplish.

As you select a response type, the options in the right panes in FDATool
change to let you set the values that define your filter. You also see that the
analysis area includes a diagram (called a design mask) that describes the
options for the filter response you choose.

By reviewing the mask you can see how the options are defined and how
to use them. While this is usually straightforward for lowpass or highpass
filter responses, setting the options for the arbitrary response types or the
peaking/notching filters is more complicated. Having the masks leads you
to your result more easily.

Changing the filter design method changes the available response type
options. Similarly, the response type you select may change the filter design
methods you can choose.

Example — Design a Notch Filter
Notch filters aim to remove one or a few frequencies from a broader spectrum.
You must specify the frequencies to remove by setting the filter design options
in FDATool appropriately:

• Response Type
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• Design Method

• Frequency Specifications

• Magnitude Specifications

Here is how you design a notch filter that removes concert A (440 Hz) from
an input musical signal spectrum.

1 Select Notching from the Differentiator list in Response Type.

2 Select IIR in Filter Design Method and choose Single Notch from the
list.

3 For the Frequency Specifications, set Units to Hz and Fs, the full scale
frequency, to 10000.

4 Set the location of the center of the notch, in either normalized frequency
or Hz. For the notch center at 440 Hz, enter 440.

5 To shape the notch, enter the bandwidth, bw, to be 40.

6 Leave theMagnitude Specification in dB (the default) and leave Apass
as 1.

7 Click Design Filter.

FDATool computes the filter coefficients and plots the filter magnitude
response in the analysis area for you to review.

When you design a single notch filter, you do not have the option of setting
the filter order — the Filter Order options are disabled.

Your filter should look about like this:

4-4



Designing Advanced Filters in FDATool

For more information about a design method, refer to the online Help system.
For instance, to get further information about the Q setting for the notch
filter in FDATool, enter

doc iirnotch

at the prompt. This opens the Help browser and displays the reference page
for function iirnotch.

Designing other filters follows a similar procedure, adjusting for different
design specification options as each design requires.

Any one of the designs may be quantized in FDATool and analyzed with the
available analyses on the Analysis menu. For more general information
about FDATool, such as the user interface and areas, refer to the FDATool
documentation in the Signal Processing Toolbox documentation. One way
to do this is to enter

doc signal/fdatool

at the prompt. The signal qualifier is necessary to open the reference page
in Signal Processing Toolbox documentation, rather than the page in Filter
Design Toolbox documentation. You might also look at the general section on
FDATool in the Signal Processing Toolbox User’s Guide.
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Switching FDATool to Quantization Mode
You use the quantization mode in FDATool to quantize filters. Quantization
represents the fourth operating mode for FDATool, along with the filter
design, filter transformation, and import modes. To switch to quantization
mode, open FDATool from the MATLAB command prompt by entering

fdatool

You see FDATool in this configuration.
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When FDATool opens, click the Set Quantization Parameters button
on the side bar. FDATool switches to quantization mode and you see the
following panel at the bottom of FDATool, with the default double-precision
option shown for Filter Arithmetic.

The Filter Arithmetic option lets you quantize filters and investigate the
effects of changing quantization settings. To enable the quantization settings
in FDATool, select Fixed-point from the Filter Arithmetic.

The quantization options appear in the lower panel of FDATool. You see tabs
that access various sets of options for quantizing your filter.
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You use the following tabs in the dialog box to perform tasks related to
quantizing filters in FDATool:

• Coefficients provides access the settings for defining the coefficient
quantization. This is the default active panel when you switch FDATool
to quantization mode without a quantized filter in the tool. When you
import a fixed-point filter into FDATool, this is the active pane when you
switch to quantization mode.

• Input/Output switches FDATool to the options for quantizing the inputs
and outputs for your filter.

• Filter Internals lets you set a variety of options for the arithmetic your
filter performs, such as how the filter handles the results of multiplication
operations or how the filter uses the accumulator.

• Apply — applies changes you make to the quantization parameters for
your filter.
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Quantizing Filters in the Filter Design and Analysis Tool

In this section...

“Setting Quantization Parameters” on page 4-9

“Coefficients Options” on page 4-10

“Input/Output Options” on page 4-12

“Filter Internals Options” on page 4-14

“Filter Internals Options for CIC Filters” on page 4-17

Setting Quantization Parameters
Quantized filters have properties that define how they quantize data you
filter. Use the Set Quantization Parameters dialog box in FDATool to set
the properties. Using options in the Set Quantization Parameters dialog
box, FDATool lets you perform a number of tasks:

• Create a quantized filter from a double-precision filter after either
importing the filter from your workspace, or using FDATool to design the
prototype filter.

• Create a quantized filter that has the default structure (Direct form II
transposed) or any structure you choose, and other property values you
select.

• Change the quantization property values for a quantized filter after you
design the filter or import it from your workspace.

When you click Set Quantization Parameters, and then change Filter
Arithmetic to Fixed-point, the quantized filter panel opens in FDATool,
with the coefficient quantization options set to default values. In this image,
you see the options for an SOS filter. Some of the options shown apply only
to SOS filters. Other filter structures present a subset of the options you
see here.
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Coefficients Options
To let you set the properties for the filter coefficients that make up your
quantized filter, FDATool lists options for numerator word length (and
denominator word length if you have an IIR filter). The following table lists
each coefficients option and a short description of what the option setting
does in the filter.

Option Name When Used Description

Numerator Word Length FIR filters only Sets the word length used to
represent numerator coefficients in
FIR filters.

Numerator Frac. Length FIR/IIR Sets the fraction length used to
interpret numerator coefficients in
FIR filters.

Numerator Range (+/-) FIR/IIR Lets you set the range the
numerators represent. You use this
instead of the Numerator Frac.
Length option to set the precision.
When you enter a value x, the
resulting range is -x to x. Range
must be a positive integer.

4-10



Quantizing Filters in the Filter Design and Analysis Tool

Option Name When Used Description

Coefficient Word Length IIR filters only Sets the word length used to
represent both numerator and
denominator coefficients in IIR
filters. You cannot set different
word lengths for the numerator and
denominator coefficients.

Denominator Frac. Length IIR filters Sets the fraction length used to
interpret denominator coefficients
in IIR filters.

Denominator Range (+/-) IIR filters Lets you set the range the
denominator coefficients represent.
You use this instead of the
Denominator Frac. Length
option to set the precision. When
you enter a value x, the resulting
range is -x to x. Range must be a
positive integer.

Best-precision fraction
lengths

All filters Directs FDATool to select the
fraction lengths for numerator
(and denominator where available)
values to maximize the filter
performance. Selecting this option
disables all of the fraction length
options for the filter.

Scale Values frac. length SOS IIR filters Sets the fraction length used to
interpret the scale values in SOS
filters.
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Option Name When Used Description

Scale Values range (+/-) SOS IIR filters Lets you set the range the SOS
scale values represent. You use
this with SOS filters to adjust the
scaling used between filter sections.
Setting this value disables the
Scale Values frac. length option.
When you enter a value x, the
resulting range is -x to x. Range
must be a positive integer.

Use unsigned
representation

All filters Tells FDATool to interpret the
coefficients as unsigned values.

Scale the numerator
coefficients to fully utilize
the entire dynamic range

All filters Directs FDATool to scale the
numerator coefficients to effectively
use the dynamic range defined by
the numerator word length and
fraction length format.

Input/Output Options
The options that specify how the quantized filter uses input and output values
are listed in the table below. In the following picture you see the options
for an SOS filter.
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Option Name When Used Description

Input Word Length All filters Sets the word length used to represent
the input to a filter.

Input fraction length All filters Sets the fraction length used to interpret
input values to filter.

Input range (+/-) All filters Lets you set the range the inputs
represent. You use this instead of the
Input fraction length option to set the
precision. When you enter a value x, the
resulting range is -x to x. Range must be
a positive integer.

Output word length All filters Sets the word length used to represent
the output from a filter.

Avoid overflow All filters Directs the filter to set the fraction length
for the input to prevent the output values
from exceeding the available range as
defined by the word length. Clearing
this option lets you set Output fraction
length.

Output fraction
length

All filters Sets the fraction length used to represent
output values from a filter.

Output range (+/-) All filters Lets you set the range the outputs
represent. You use this instead of the
Output fraction length option to set
the precision. When you enter a value
x, the resulting range is -x to x. Range
must be a positive integer.

Stage input word
length

SOS filters only Sets the word length used to represent
the input to an SOS filter section.

Avoid overflow SOS filters only Directs the filter to use a fraction length
for stage inputs that prevents overflows
in the values. When you clear this option,
you can set Stage input fraction
length.
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Option Name When Used Description

Stage input fraction
length

SOS filters only Sets the fraction length used to represent
input to a section of an SOS filter.

Stage output word
length

SOS filters only Sets the word length used to represent
the output from an SOS filter section.

Avoid overflow SOS filters only Directs the filter to use a fraction length
for stage outputs that prevents overflows
in the values. When you clear this option,
you can set Stage output fraction
length.

Stage output fraction
length

SOS filters only Sets the fraction length used to represent
the output from a section of an SOS filter.

Filter Internals Options
The options that specify how the quantized filter performs arithmetic
operations are listed in the table after the figure. In the following picture
you see the options for an SOS filter.
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Option

Equivalent Filter
Property (Using
Wildcard *) Description

Round towards RoundMode Sets the mode the filter uses to quantize
numeric values when the values lie
between representable values for the
data format (word and fraction lengths).
Choose from one of:

• ceil - Round toward positive infinity.

• convergent - Round to the closest
representable integer. Ties round to
the nearest even stored integer. This
is the least biased of the methods
available in this software.

• fix/zero - Round toward zero.

• floor - Round toward negative
infinity.

• nearest - Round toward nearest. Ties
round toward positive infinity.

• round - Round toward nearest.
Ties round toward negative infinity
for negative numbers, and toward
positive infinity for positive numbers.

Overflow Mode OverflowMode Sets the mode used to respond to
overflow conditions in fixed-point
arithmetic. Choose from either
saturate (limit the output to the largest
positive or negative representable value)
or wrap (set overflowing values to the
nearest representable value using
modular arithmetic.

Filter Product (Multiply) Options
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Option

Equivalent Filter
Property (Using
Wildcard *) Description

Product Mode ProductMode Determines how the filter handles the
output of product operations. Choose
from full precision (FullPrecision), or
whether to keep the most significant
bit (KeepMSB) or least significant bit
(KeepLSB) in the result when you need to
shorten the word length. Specify all
lets you set the fraction length applied
to the results of product operations.

Product word length *ProdWordLength Sets the word length applied to interpret
the results of multiply operations.

Num. fraction length NumProdFracLength Sets the fraction length used to interpret
the results of product operations that
involve numerator coefficients.

Den. fraction length DenProdFracLength Sets the fraction length used to interpret
the results of product operations that
involve denominator coefficients.

Filter Sum Options

Accum. mode AccumMode Determines how the accumulator
outputs stored values. Choose from
full precision (FullPrecision), or
whether to keep the most significant
bits (KeepMSB) or least significant
bits (KeepLSB) when output results
need shorter word length than the
accumulator supports. To let you set
the word length and the precision (the
fraction length) used by the output from
the accumulator, set this to Specify
all.

Accum. word length *AccumWordLength Sets the word length used to store data
in the accumulator/buffer.
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Option

Equivalent Filter
Property (Using
Wildcard *) Description

Num. fraction length NumAccumFracLength Sets the fraction length used to interpret
the numerator coefficients.

Den. fraction length DenAccumFracLength Sets the fraction length the filter uses to
interpret denominator coefficients.

Cast signals before
sum

CastBeforeSum Specifies whether to cast numeric data
to the appropriate accumulator format
(as shown in the signal flow diagrams for
each filter structure) before performing
sum operations.

Filter State Options

State word length *StateWordLength Sets the word length used to represent
the filter states. Applied to both
numerator- and denominator-related
states

Avoid overflow None Prevent overflows in arithmetic
calculations by setting the fraction
length appropriately.

State fraction length *StateFracLength Lets you set the fraction length
applied to interpret the filter states.
Applied to both numerator- and
denominator-related states

Note When you apply changes to the values in the Filter Internals pane, the
plots for the Magnitude response estimate and Round-off noise power
spectrum analyses update to reflect those changes. Other types of analyses
are not affected by changes to the values in the Filter Internals pane.

Filter Internals Options for CIC Filters
CIC filters use slightly different options for specifying the fixed-point
arithmetic in the filter. The next table shows and describes the options.
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Example — Quantize Double-Precision Filters
When you are quantizing a double-precision filter by switching to fixed-point
or single-precision floating point arithmetic, follow these steps.

1 Click Set Quantization Parameters to display the Set Quantization
Parameters pane in FDATool.

2 Select Single-precision floating point or Fixed-point from Filter
arithmetic.

When you select one of the optional arithmetic settings, FDATool quantizes
the current filter according to the settings of the options in the Set
Quantization Parameter panes, and changes the information displayed in
the analysis area to show quantized filter data.

3 In the quantization panes, set the options for your filter. Set options for
Coefficients, Input/Output, and Filter Internals.

4 Click Apply.

FDATool quantizes your filter using your new settings.

5 Use the analysis features in FDATool to determine whether your new
quantized filter meets your requirements.

Example — Change the Quantization Properties of Quantized
Filters
When you are changing the settings for the quantization of a quantized filter,
or after you import a quantized filter from your MATLAB workspace, follow
these steps to set the property values for the filter:

1 Verify that the current filter is quantized.

2 Click Set Quantization Parameters to display the Set Quantization
Parameters panel.

3 Review and select property settings for the filter quantization:
Coefficients, Input/Output, and Filter Internals. Settings for options
on these panes determine how your filter quantizes data during filtering
operations.
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4 Click Apply to update your current quantized filter to use the new
quantization property settings from Step 3.

5 Use the analysis features in FDATool to determine whether your new
quantized filter meets your requirements.
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Analyzing Filters with a Noise-Based Method

In this section...

“Using the Magnitude Response Estimate Method” on page 4-20

“Comparing the Estimated and Theoretical Magnitude Responses” on page
4-25

“Choosing Quantized Filter Structures” on page 4-26

“Converting the Structure of a Quantized Filter” on page 4-26

“Converting Filters to Second-Order Sections Form” on page 4-27

Using the Magnitude Response Estimate Method
After you design and quantize your filter, the Magnitude Response
Estimate option on the Analysis menu lets you apply the noise loading
method to your filter. When you select Analysis > Magnitude Response
Estimate from the menubar, FDATool immediately starts the Monte Carlo
trials that form the basis for the method and runs the analysis, ending by
displaying the results in the analysis area in FDATool.

With the noise-based method, you estimate the complex frequency response
for your filter as determined by applying a noise- like signal to the filter input.
Magnitude Response Estimate uses the Monte Carlo trials to generate a
noise signal that contains complete frequency content across the range 0 to
Fs. The first time you run the analysis, magnitude response estimate uses
default settings for the various conditions that define the process, such as the
number of test points and the number of trials.

Analysis Parameter
Default
Setting Description

Number of Points 512 Number of equally spaced points
around the upper half of the unit
circle.

Frequency Range 0 to Fs/2 Frequency range of the plot
x-axis.
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Analysis Parameter
Default
Setting Description

Frequency Units Hz Units for specifying the frequency
range.

Sampling Frequency 48000 Inverse of the sampling period.

Frequency Scale dB Units used for the y-axis display
of the output.

Normalized
Frequency

Off Use normalized frequency for the
display.

After your first analysis run ends, open the Analysis Parameters dialog
box and adjust your settings appropriately, such as changing the number of
trials or number of points.

To open the Analysis Parameters dialog box, use either of the next
procedures when you have a quantized filter in FDATool:

• Select Analysis > Analysis Parameters from the menu bar

• Right-click in the filter analysis area and select Analysis Parameters
from the context menu

Whichever option you choose opens the dialog box as shown in the figure.
Notice that the settings for the options reflect the defaults.
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Example — Noise Method Applied to a Filter
To demonstrate the magnitude response estimate method, start by creating
a quantized filter. For this example, use FDATool to design a sixth-order
Butterworth IIR filter.

To Use Noise-Based Analysis in FDATool

1 Enter fdatool at the MATLAB prompt to launch FDATool.

2 Under Response Type, select Highpass.

3 Select IIR in Design Method. Then select Butterworth.

4 To set the filter order to 6, select Specify order under Filter Order.
Enter 6 in the text box.

5 Click Design Filter.

In FDATool, the analysis area changes to display the magnitude response
for your filter.

6 To generate the quantized version of your filter, using default quantizer
settings, click on the side bar.
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FDATool switches to quantization mode and displays the quantization
panel.

7 From Filter arithmetic, select fixed-point.

Now the analysis areas shows the magnitude response for both filters —
your original filter and the fixed-point arithmetic version.

8 Finally, to use noise-based estimation on your quantized filter, select
Analysis > Magnitude Response Estimate from the menubar.

FDATool runs the trial, calculates the estimated magnitude response for
the filter, and displays the result in the analysis area as shown in this
figure.

In the above figure you see the magnitude response as estimated by the
analysis method.

To View the Noise Power Spectrum
When you use the noise method to estimate the magnitude response of a filter,
FDATool simulates and applies a spectrum of noise values to test your filter
response. While the simulated noise is essentially white, you might want to
see the actual spectrum that FDATool used to test your filter.
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From the Analysis menu bar option, select Round-off Noise Power
Spectrum. In the analysis area in FDATool, you see the spectrum of the
noise used to estimate the filter response. The details of the noise spectrum,
such as the range and number of data points, appear in the Analysis
Parameters dialog box.

For more information, refer to McClellan, et al., Computer-Based Exercises
for Signal Processing Using MATLAB 5, Prentice-Hall, 1998. See Project 5:
Quantization Noise in Digital Filters, page 231.

To Change Your Noise Analysis Parameters
In “Example — Noise Method Applied to a Filter” on page 4-22, you used
synthetic white noise to estimate the magnitude response for a fixed-point
highpass Butterworth filter. Since you ran the estimate only once in FDATool,
your noise analysis used the default analysis parameters settings shown in
“Using the Magnitude Response Estimate Method” on page 4-20.

To change the settings, follow these steps after the first time you use the
noise estimate on your quantized filter.

1 With the results from running the noise estimating method displayed in
the FDATool analysis area, select Analysis > Analysis Parameters from
the menubar.

To give you access to the analysis parameters, the Analysis Parameters
dialog box opens as shown here (with default settings).

4-24



Analyzing Filters with a Noise-Based Method

2 To use more points in the spectrum to estimate the magnitude response,
change Number of Points to 1024 and click OK to run the analysis.

FDATool closes the Analysis Parameters dialog box and reruns the noise
estimate, returning the results in the analysis area.

To rerun the test without closing the dialog box, press Enter after you type
your new value into a setting, then click Apply. Now FDATool runs the
test without closing the dialog box. When you want to try many different
settings for the noise-based analysis, this is a useful shortcut.

Comparing the Estimated and Theoretical Magnitude
Responses
An important measure of the effectiveness of the noise method for estimating
the magnitude response of a quantized filter is to compare the estimated
response to the theoretical response.

One way to do this comparison is to overlay the theoretical response on the
estimated response. While you have the Magnitude Response Estimate
displaying in FDATool, select Analysis > Overlay Analysis from the menu
bar. Then selectMagnitude Response to show both response curves plotted
together in the analysis area.
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Choosing Quantized Filter Structures
FDATool lets you change the structure of any quantized filter. Use the
Convert structure option to change the structure of your filter to one that
meets your needs.

To learn about changing the structure of a filter in FDATool, refer to
“Converting the Filter Structure”in your Signal Processing Toolbox
documentation.

Converting the Structure of a Quantized Filter
You use the Convert structure option to change the structure of filter. When
the Source is Designed(Quantized) or Imported(Quantized), Convert
structure lets you recast the filter to one of the following structures:

• “Direct Form II Transposed Filter Structure”

• “Direct Form I Transposed Filter Structure”

• “Direct Form II Filter Structure”

• “Direct Form I Filter Structure”

• “Direct Form Finite Impulse Response (FIR) Filter Structure”

• “Direct Form FIR Transposed Filter Structure”

• “Lattice Autoregressive Moving Average (ARMA) Filter Structure”

• dfilt.calattice

• dfilt.calatticepc

• “Direct Form Antisymmetric FIR Filter Structure (Any Order)”

Starting from any quantized filter, you can convert to one of the following
representation:

• Direct form I

• Direct form II

• Direct form I transposed

• Direct form II transposed
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• Lattice ARMA

Additionally, FDATool lets you do the following conversions:

• Minimum phase FIR filter to Lattice MA minimum phase

• Maximum phase FIR filter to Lattice MA maximum phase

• Allpass filters to Lattice allpass

Refer to “FilterStructure” for details about each of these structures.

Converting Filters to Second-Order Sections Form
To learn about using FDATool to convert your quantized filter to use
second-order sections, refer to “Converting to Second-Order Sections” in your
Signal Processing Toolbox documentation. You might notice that filters
you design in FDATool, rather than filters you imported, are implemented
in SOS form.

To View Filter Structures in FDATool
To open the demonstration, click Help > Show filter structures. After the
Help browser opens, you see the reference page for the current filter. You find
the filter structure signal flow diagram on this reference page, or you can
navigate to reference pages for other filter.
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Scaling Second-Order Section Filters

In this section...

“Using the Reordering and Scaling Second-Order Sections Dialog Box” on
page 4-28

“Example — Scale an SOS Filter” on page 4-30

Using the Reordering and Scaling Second-Order
Sections Dialog Box
FDATool provides the ability to scale SOS filters after you create them. Using
options on the Reordering and Scaling Second-Order Sections dialog box,
FDATool scales either or both the filter numerators and filter scale values
according to your choices for the scaling options.
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Parameter Description and Valid Value

Scale Apply any scaling options to the filter. Select this
when you are reordering your SOS filter and you
want to scale it at the same time. Or when you
are scaling your filter, with or without reordering.
Scaling is disabled by default.

No Overflow — High
SNR slider

Lets you set whether scaling favors reducing
arithmetic overflow in the filter or maximizing
the signal-to-noise ratio (SNR)) at the filter
output. Moving the slider to the right increases
the emphasis on SNR at the expense of possible
overflows. The markings indicate the P-norm
applied to achieve the desired result in SNR or
overflow protection. For more information about
the P-norm settings, refer to norm for details.

Maximum
Numerator

Maximum allowed value for numerator
coefficients after scaling.

Numerator
Constraint

Specifies whether and how to constrain
numerator coefficient values. Options are none,
normalize, power of 2, and unit. Choosing
none lets the scaling use any scale value for
the numerators by removing any constraints
on the numerators, except that the coefficients
will be clipped if they exceed the Maximum
Numerator. With Normalize the maximum
absolute value of the numerator is forced to equal
the Maximum Numerator value (for all other
constraints, the Maximum Numerator is only
an upper limit, above which coefficients will be
clipped). The power of 2 option forces scaling to
use numerator values that are powers of 2, such
as 2 or 0.5. With unit, the leading coefficient of
each numerator is forced to a value of 1.
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Parameter Description and Valid Value

Overflow Mode Sets the way the filter handles arithmetic
overflow situations during scaling. Choose
from either saturate (limit the output to the
largest positive or negative representable value)
or wrap (set overflowing values to the nearest
representable value using modular arithmetic.

Scale Value
Constraint

Specify whether to constrain the filter scale
values, and how to constrain them. Valid options
are unit, power of 2, and none. Choosing unit
for the constraint disables the Max. Scale
Value setting and forces scale values to equal
1. Power of 2 constrains the scale values to be
powers of 2, such as 2 or 0.5, while none removes
any constraint on the scale values, except that
they cannot exceed theMax. Scale Value.

Max. Scale Value Sets the maximum allowed scale values. SOS
filter scaling applies theMax. Scale Value limit
only when you set Scale Value Constraint to
a value other than unit (the default setting).
Setting a maximum scale value removes any
other limits on the scale values.

Revert to Original
Filter

Returns your filter to the original scaling. Being
able to revert to your original filter makes it
easier to assess the results of scaling your filter.

Various combinations of settings let you scale filter numerators without
changing the scale values, or adjust the filter scale values without changing
the numerators. There is no scaling control for denominators.

Example — Scale an SOS Filter
Start the process by designing a lowpass elliptical filter in FDATool.

1 Launch FDATool.

2 In Response Type, select Lowpass.
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3 In Design Method, select IIR and Elliptic from the IIR design methods
list.

4 Select Minimum Order for the filter.

5 Switch the frequency units by choosing Normalized(0 to 1) from the
Units list.

6 To set the passband specifications, enter 0.45 for wpass and 0.55 for
wstop. Finally, inMagnitude Specifications, set Astop to 60.

7 Click Design Filter to design the filter.

After FDATool finishes designing the filter, you see the following plot and
settings in the tool.
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You kept the Options setting for Match exactly as both, meaning the
filter design matches the specification for the passband and the stopband.

8 To switch to scaling the filter, select Edit > Reorder and Scale
Second-Order Sections from the menu bar.

Your selection opens the Reordering and Scaling Second-Order
Sections dialog box shown here.

4-32



Scaling Second-Order Section Filters

9 To see the filter coefficients, return to FDATool and select Filter
Coefficients from the Analysis menu. FDATool displays the coefficients
and scale values in FDATool.
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With the coefficients displayed you can see the effects of scaling your filter
directly in the scale values and filter coefficients.

Now try scaling the filter in a few different ways. First scale the filter to
maximize the SNR.

1 Return to the Reordering and Scaling Second-Order Sections dialog
box and select None for Reordering in the left pane. This prevents
FDATool from reordering the filter sections when you rescale the filter.

2 Move the No Overflow—High SNR slider from No Overflow to High
SNR.

3 Click Apply to scale the filter and leave the dialog box open.

After a few moments, FDATool updates the coefficients displayed so you
see the new scaling, as shown in the following figure.
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All of the scale factors are now 1, and the SOS matrix of coefficients shows
that none of the numerator coefficients are 1 and the first denominator
coefficient of each section is 1.

4 Click Revert to Original Filter to restore the filter to the original
settings for scaling and coefficients.
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Reordering the Sections of Second-Order Section Filters

Switching FDATool to Reorder Filters
FDATool design most discrete-time filters in second-order sections. Generally,
SOS filters resist the effects of quantization changes when you create
fixed-point filters. After you have a second-order section filter in FDATool,
either one you designed in the tool, or one you imported, FDATool provides
the capability to change the order of the sections that compose the filter. Any
SOS filter in FDATool allows reordering of the sections.

To reorder the sections of a filter, you access the Reorder and Scaling of
Second-Order Sections dialog box in FDATool.

With your SOS filter in FDATool, select Edit > Reorder and Scale from
the menu bar. FDATool returns the reordering dialog box shown here with
the default settings.
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Controls on the Reordering and Scaling of Second-Order Sections dialog box

In this dialog box, the left-hand side contains options for reordering SOS
filters. On the right you see the scaling options. These are independent —
reordering your filter does not require scaling (note the Scale option) and
scaling does not require that you reorder your filter (note the None option
under Reordering). For more about scaling SOS filters, refer to “Scaling
Second-Order Section Filters” on page 4-28 and to scale in the reference
section.

Reordering SOS filters involves using the options in the Reordering and
Scaling of Second-Order Sections dialog box. The following table lists
each reorder option and provides a description of what the option does.
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Control Option Description

Auto Reorders the filter sections to minimize the output
noise power of the filter. Note that different
ordering applies to each specification type, such as
lowpass or highpass. Automatic ordering adapts to
the specification type of your filter.

None Does no reordering on your filter. Selecting
None lets you scale your filter without applying
reordering at the same time. When you access this
dialog box with a current filter, this is the default
setting — no reordering is applied.

Least selective
section to most
selective section

Rearranges the filter sections so the least
restrictive (lowest Q) section is the first section
and the most restrictive (highest Q) section is the
last section.

Most selective
section to least
selective section

Rearranges the filter sections so the most
restrictive (highest Q) section is the first section
and the least restrictive (lowest Q) section is the
last section.

Custom reordering Lets you specify the section ordering to use by
enabling the Numerator Order and Denominator
Order options

Numerator Order Specify new ordering for the sections of your SOS
filter. Enter a vector of the indices of the sections
in the order in which to rearrange them. For
example, a filter with five sections has indices 1,
2, 3, 4, and 5. To switch the second and fourth
sections, the vector would be [1,4,3,2,5].

Use Numerator
Order

Rearranges the denominators in the order assigned
to the numerators.
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Control Option Description

Specify Lets you specify the order of the denominators,
rather than using the numerator order. Enter a
vector of the indices of the sections to specify the
order of the denominators to use. For example, a
filter with five sections has indices 1, 2, 3, 4, and
5. To switch the second and fourth sections, the
vector would be [1,4,3,2,5].

Use Numerator
Order

Reorders the scale values according to the order
of the numerators.

Specify Lets you specify the order of the scale values,
rather than using the numerator order. Enter a
vector of the indices of the sections to specify the
order of the denominators to use. For example, a
filter with five sections has indices 1, 2, 3, 4, and
5. To switch the second and fourth sections, the
vector would be [1,4,3,2,5].

Revert to Original
Filter

Returns your filter to the original section ordering.
Being able to revert to your original filter makes
comparing the results of changing the order of the
sections easier to assess.

Example — Reorder an SOS Filter
With FDATool open and a second-order filter as the current filter, you use the
following process to access the reordering capability and reorder you filter.
Start by launching FDATool from the command prompt.

1 Enter fdatool at the command prompt to launch FDATool.

2 Design a lowpass Butterworth filter with order 10 and the default
frequency specifications by entering the following settings:

• Under Response Type select Lowpass.

• Under Design Method, select IIR and Butterworth from the list.

• Specify the order equal to 10 in Specify order under Filter Order.

• Keep the default Fs and Fc values in Frequency Specifications.
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3 Click Design Filter.

FDATool design the Butterworth filter and returns your filter as a
Direct-Form II filter implemented with second-order sections. You see the
specifications in the Current Filter Information area.

With the second-order filter in FDATool, reordering the filter uses the
Reordering and Scaling of Second-Order Sections feature in FDATool
(also available in Filter Visualization Tool, fvtool).

4 To reorder your filter, select Edit > Reorder and Scale Second-Order
Sections from the FDATool menus. FDATool opens the following dialog
box that controls reordering of the sections of your filter.

Now you are ready to reorder the sections of your filter. Note that FDATool
performs the reordering on the current filter in the session.
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Use Least Selective to Most Selective Section Reordering
To let FDATool reorder your filter so the least selective section is first and the
most selective section is last, perform the following steps in the Reordering
and Scaling of Second-Order Sections dialog box.

1 In Reordering, select Least selective section to most selective
section.

2 To prevent filter scaling at the same time, clear Scale in Scaling.

3 In FDATool, select View > SOS View from the menu bar so you see the
sections of your filter displayed in FDATool.

4 In the SOS View dialog box, select Individual sections. Making this
choice configures FDATool to show the magnitude response curves for each
section of your filter in the analysis area.

5 Back in the Reordering and Scaling of Second-Order Sections dialog
box, click Apply to reorder your filter according to the Qs of the filter
sections, and keep the dialog box open. In response, FDATool presents
the responses for each filter section (there should be five sections) in the
analysis area.
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In the next two figures you can compare the ordering of the sections of
your filter. In the first figure, your original filter sections appear. In the
second figure, the sections have been rearranged from least selective to
most selective.

You see what reordering does, although the result is a bit subtle. Now try
custom reordering the sections of your filter or using the most selective to
least selective reordering option.
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Viewing SOS Filter Sections

In this section...

“Using the SOS View Dialog Box” on page 4-43

“Example — View the Sections of SOS Filters” on page 4-46

Using the SOS View Dialog Box
Since you can design and reorder the sections of SOS filters, FDATool provides
the ability to view the filter sections in the analysis area — SOS View. Once
you have a second-order section filter as your current filter in FDATool,
you turn on the SOS View option to see the filter sections individually, or
cumulatively, or even only some of the sections. Enabling SOS View puts
FDATool in a mode where all second-order section filters display sections until
you disable the SOS View option. SOS View mode applies to any analysis you
display in the analysis area. For example, if you configure FDATool to show
the phase responses for filters, enabling SOS View means FDATool displays
the phase response for each section of SOS filters.

Controls on the SOS View Dialog Box

SOS View uses a few options to control how FDATool displays the sections,
or which sections to display. When you select View > SOS View from the
FDATool menu bar, you see this dialog box containing options to configure
SOS View operation.
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By default, SOS View shows the overall response of SOS filters. Options in
the SOS View dialog box let you change the display. This table lists all the
options and describes the effects of each.

Option Description

Overall Filter This is the familiar display in FDATool. For
a second-order section filter you see only the
overall response rather than the responses for
the individual sections. This is the default
configuration.

Individual sections When you select this option, FDATool displays
the response for each section as a curve.
If your filter has five sections you see five
response curves, one for each section, and they
are independent. Compare to Cumulative
sections.
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Option Description

Cumulative sections When you select this option, FDATool
displays the response for each section as the
accumulated response of all prior sections in
the filter. If your filter has five sections you
see five response curves:

• The first curve plots the response for the
first filter section.

• The second curve plots the response for the
combined first and second sections.

• The third curve plots the response for the
first, second, and third sections combined.

And so on until all filter sections appear in the
display. The final curve represents the overall
filter response. Compare to Cumulative
sections and Overall Filter.

User defined Here you define which sections to display, and
in which order. Selecting this option enables
the text box where you enter a cell array of
the indices of the filter sections. Each index
represents one section. Entering one index
plots one response. Entering something like
{1:2} plots the combined response of sections 1
and 2. If you have a filter with four sections,
the entry {1:4} plots the combined response for
all four sections, whereas {1,2,3,4} plots the
response for each section. Note that after you
enter the cell array, you need to click OK or
Apply to update the FDATool analysis area to
the new SOS View configuration.

Use secondary-scaling
points

This directs FDATool to use the secondary
scaling points in the sections to determine
where to split the sections. This option applies
only when the filter is a df2sos or df1tsos
filter. For these structures, the secondary
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Option Description

scaling points refer to the scaling locations
between the recursive and the nonrecursive
parts of the section (the "middle" of the section).
By default, secondary-scaling points is not
enabled. You use this with the Cumulative
sections option only.

Example — View the Sections of SOS Filters
After you design or import an SOS filter in to FDATool, the SOS view option
lets you see the per section performance of your filter. Enabling SOS View
from the View menu in FDATool configures the tool to display the sections of
SOS filters whenever the current filter is an SOS filter.

These next steps demonstrate using SOS View to see your filter sections
displayed in FDATool.

1 Launch FDATool.

2 Create a lowpass SOS filter using the Butterworth design method. Specify
the filter order to be 6. Using a low order filter makes seeing the sections
more clear.

3 Design your new filter by clicking Design Filter.

FDATool design your filter and show you the magnitude response in the
analysis area. In Current Filter Information you see the specifications for
your filter. You should have a sixth-order Direct-Form II, Second-Order
Sections filter with three sections.

4 To enable SOS View, select View > SOS View from the menu bar.

Now you see the SOS View dialog box in FDATool. Options here let you
specify how to display the filter sections.
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By default the analysis area in FDATool shows the overall filter response,
not the individual filter section responses. This dialog box lets you change
the display configuration to see the sections.

5 To see the magnitude responses for each filter section, select Individual
sections.

6 Click Apply to update FDATool to display the responses for each filter
section. The analysis area changes to show you something like the
following figure.
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If you switch FDATool to display filter phase responses, you see the phase
response for each filter section in the analysis area.

7 To define your own display of the sections, you use the User defined
option and enter a vector of section indices to display. Now you see a
display of the first section response, and the cumulative first, second, and
third sections response:

• Select User defined to enable the text entry box in the dialog box.

4-48



Viewing SOS Filter Sections

• Enter the cell array {1,1:3} to specify that FDATool should display the
response of the first section and the cumulative response of the first
three sections of the filter.

8 To apply your new SOS View selection, click Apply or OK (which closes
the SOS View dialog box).

In the FDATool analysis area you see two curves — one for the response
of the first filter section and one for the combined response of sections
1, 2, and 3.
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Importing and Exporting Quantized Filters

In this section...

“Overview and Structures” on page 4-50

“Example — Import Quantized Filters” on page 4-51

“To Export Quantized Filters” on page 4-52

Overview and Structures
When you import a quantized filter into FDATool, or export a quantized filter
from FDATool to your workspace, the import and export functions use objects
and you specify the filter as a variable. This contrasts with importing and
exporting nonquantized filters, where you select the filter structure and enter
the filter numerator and denominator for the filter transfer function.

You have the option of exporting quantized filters to your MATLAB
workspace, exporting them to text files, or exporting them to MAT-files.

For general information about importing and exporting filters in FDATool,
refer to “FDATool: A Filter Design and Analysis GUI” in the Signal Processing
Toolbox User’s Guide.

FDATool imports quantized filters having the following structures:

• Direct form I

• Direct form II

• Direct form I transposed

• Direct form II transposed

• Direct form symmetric FIR

• Direct form antisymmetric FIR

• Lattice allpass

• Lattice AR

• Lattice MA minimum phase
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• Lattice MA maximum phase

• Lattice ARMA

• Lattice coupled-allpass

• Lattice coupled-allpass power complementary

Example — Import Quantized Filters
After you design or open a quantized filter in your MATLAB workspace,
FDATool lets you import the filter for analysis. Follow these steps to import
your filter in to FDATool:

1 Open FDATool.

2 Select Filter > Import Filter from the menu bar.

In the lower region of FDATool, the Design Filter pane becomes Import
Filter, and options appear for importing quantized filters, as shown.

3 From the Filter Structure list, select Filter object.

The options for importing filters change to include:

• Discrete filter — Enter the variable name for the discrete-time,
fixed-point filter in your workspace.
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• Frequency units — Select the frequency units from the Units list
under Sampling Frequency, and specify the sampling frequency value
in Fs if needed. Your sampling frequency must correspond to the units
you select. For example, when you select Normalized (0 to 1), Fs
defaults to one. But if you choose one of the frequency options, enter the
sampling frequency in your selected units. If you have the sampling
frequency defined in your workspace as a variable, enter the variable
name for the sampling frequency.

4 Click Import to import the filter.

FDATool checks your workspace for the specified filter. It imports the filter
if it finds it, displaying the magnitude response for the filter in the analysis
area. If it cannot find the filter it returns an FDATool Error dialog box.

Note If, during any FDATool session, you switch to quantization mode and
create a fixed-point filter, FDATool remains in quantization mode. If you
import a double-precision filter, FDATool automatically quantizes your
imported filter applying the most recent quantization parameters.
When you check the current filter information for your imported filter, it
will indicate that the filter is Source: imported (quantized) even though
you did not import a quantized filter.

To Export Quantized Filters
To save your filter design, FDATool lets you export the quantized filter to
your MATLAB workspace (or you can save the current session in FDATool).
When you choose to save the quantized filter by exporting it, you select one
of these options:

• Export to your MATLAB workspace

• Export to a text file

• Export to a MAT-file

Example — Export Coefficients or Objects to the Workspace
You can save the filter as filter coefficients variables or as a dfilt filter object
variable. To save the filter to the MATLAB workspace:
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1 Select Export from the File menu. The Export dialog box appears.

2 Select Workspace from the Export To list.

3 Select Coefficients from the Export As list to save the filter coefficients
or select Objects to save the filter in a filter object.

4 For coefficients, assign variable names using the Numerator and
Denominator options under Variable Names. For objects, assign
the variable name in the Discrete or Quantized filter option. If you
have variables with the same names in your workspace and you want to
overwrite them, select the Overwrite Variables box.

5 Click the OK button

If you try to export the filter to a variable name that exists in your
workspace, and you did not select Overwrite existing variables,
FDATool stops the export operation and returns a warning that the
variable you specified as the quantized filter name already exists in the
workspace. To continue to export the filter to the existing variable, click
OK to dismiss the warning dialog box, select the Overwrite existing
variables check box and click OK or Apply.

Getting Filter Coefficients After Exporting
To extract the filter coefficients from your quantized filter after you export
the filter to MATLAB, use the celldisp function in MATLAB. For example,
create a quantized filter in FDATool and export the filter as Hq. To extract the
filter coefficients for Hq, use

celldisp(Hq.referencecoefficients)

which returns the cell array containing the filter reference coefficients, or

celldisp(Hq.quantizedcoefficients

to return the quantized coefficients.

Example — Exporting as a Text File
To save your quantized filter as a text file, follow these steps:
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1 Select Export from the File menu.

2 Select Text-file under Export to.

3 Click OK to export the filter and close the dialog box. Click Apply to export
the filter without closing the Export dialog box. Clicking Apply lets
you export your quantized filter to more than one name without leaving
the Export dialog box.

The Export Filter Coefficients to Text-file dialog box appears. This is
the standard Microsoft Windows save file dialog box.

4 Choose or enter a directory and filename for the text file and click OK.

FDATool exports your quantized filter as a text file with the name you
provided, and the MATLAB editor opens, displaying the file for editing.

Example — Exporting as a MAT-File
To save your quantized filter as a MAT-file, follow these steps:

1 Select Export from the File menu.

2 Select MAT-file under Export to.

3 Assign a variable name for the filter.

4 Click OK to export the filter and close the dialog box. Click Apply to export
the filter without closing the Export dialog box. Clicking Apply lets
you export your quantized filter to more than one name without leaving
the Export dialog box.

The Export Filter Coefficients to MAT-file dialog box appears. This is
the standard Microsoft Windows save file dialog box.

5 Choose or enter a directory and filename for the text file and click OK.

FDATool exports your quantized filter as a MAT-file with the specified
name.
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Importing XILINX Coefficient (.COE) Files

Example — Import XILINX .COE Files
You can import XILINX coefficients (.coe) files into FDATool to create
quantized filters directly using the imported filter coefficients.

To use the import file feature:

1 Select File > Import Filter From XILINX Coefficient (.COE) File
in FDATool.

2 In the Import Filter From XILINX Coefficient (.COE) File dialog box,
find and select the .coe file to import.

3 Click Open to dismiss the dialog box and start the import process.

FDATool imports the coefficient file and creates a quantized, single-section,
direct-form FIR filter.
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Transforming Filters

In this section...

“FDATool Filter Transformation Capabilities” on page 4-56

“Original Filter Type” on page 4-57

“Frequency Point to Transform” on page 4-61

“Transformed Filter Type” on page 4-61

“Specify Desired Frequency Location” on page 4-62

FDATool Filter Transformation Capabilities
The toolbox provides functions for transforming filters between various forms.
When you use FDATool with the toolbox installed, a side bar button and a
menu bar option enable you to use the Transform Filter panel to transform
filters as well as using the command line functions.

From the selection on the FDATool menu bar — Transformations — you
can transform lowpass FIR and IIR filters to a variety of passband shapes.

You can convert your FIR filters from:

• Lowpass to lowpass.

• Lowpass to highpass.

For IIR filters, you can convert from:

• Lowpass to lowpass.

• Lowpass to highpass.

• Lowpass to bandpass.

• Lowpass to bandstop.

When you click the Transform Filter button, , on the side bar, the
Transform Filter panel opens in FDATool, as shown here.
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Your options for Original filter type refer to the type of your current filter
to transform. If you select lowpass, you can transform your lowpass filter
to another lowpass filter or to a highpass filter, or to numerous other filter
formats, real and complex.

Note When your original filter is an FIR filter, both the FIR and IIR
transformed filter type options appear on the Transformed filter type list.
Both options remain active because you can apply the IIR transforms to an
FIR filter. If your source is as IIR filter, only the IIR transformed filter
options show on the list.

Original Filter Type
Select the magnitude response of the filter you are transforming from the list.
Your selection changes the types of filters you can transform to. For example:

• When you select Lowpass with an IIR filter, your transformed filter type
can be

- Lowpass

- Highpass

- Bandpass

- Bandstop

- Multiband
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- Bandpass (complex)

- Bandstop (complex)

- Multiband (complex)

• When you select Lowpass with an FIR filter, your transformed filter
type can be

- Lowpass

- Lowpass (FIR)

- Highpass

- Highpass (FIR) narrowband

- Highpass (FIR) wideband

- Bandpass

- Bandstop

- Multiband

- Bandpass (complex)

- Bandstop (complex)

- Multiband (complex)

In the following table you see each available original filter type and all the
types of filter to which you can transform your original.

Original Filter Available Transformed Filter Types

Lowpass FIR • Lowpass

• Lowpass (FIR)

• Highpass

• Highpass (FIR) narrowband

• Highpass (FIR) wideband

• Bandpass

• Bandstop

• Multiband
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Original Filter Available Transformed Filter Types

• Bandpass (complex)

• Bandstop (complex)

• Multiband (complex)

Lowpass IIR • Lowpass

• Highpass

• Bandpass

• Bandstop

• Multiband

• Bandpass (complex)

• Bandstop (complex)

• Multiband (complex)

Highpass FIR • Lowpass

• Lowpass (FIR) narrowband

• Lowpass (FIR) wideband

• Highpass (FIR)

• Highpass

• Bandpass

• Bandstop

• Multiband

• Bandpass (complex)

• Bandstop (complex)

• Multiband (complex)
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Original Filter Available Transformed Filter Types

Highpass IIR • Lowpass

• Highpass

• Bandpass

• Bandstop

• Multiband

• Bandpass (complex)

• Bandstop (complex)

• Multiband (complex)

Bandpass FIR • Bandpass

• Bandpass (FIR)

Bandpass IIR Bandpass

Bandstop FIR • Bandstop

• Bandstop (FIR)

Bandstop IIR Bandstop

Note also that the transform options change depending on whether your
original filter is FIR or IIR. Starting from an IIR filter, you can transform to
IIR or FIR forms. With an IIR original filter, you are limited to IIR target
filters.

After selecting your response type, use Frequency point to transform to
specify the magnitude response point in your original filter to transfer to
your target filter. Your target filter inherits the performance features of your
original filter, such as passband ripple, while changing to the new response
form.

For more information about transforming filters, refer to “Frequency
Transformations for Real Filters” on page 3-11 and “Frequency
Transformations for Complex Filters” on page 3-26.
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Frequency Point to Transform
The frequency point you enter in this field identifies a magnitude response
value (in dB) on the magnitude response curve.

When you enter frequency values in the Specify desired frequency
location option, the frequency transformation tries to set the magnitude
response of the transformed filter to the value identified by the frequency
point you enter in this field.

While you can enter any location, generally you should specify a filter
passband or stopband edge, or a value in the passband or stopband.

The Frequency point to transform sets the magnitude response at the
values you enter in Specify desired frequency location. Specify a value
that lies at either the edge of the stopband or the edge of the passband.

If, for example, you are creating a bandpass filter from a highpass filter, the
transformation algorithm sets the magnitude response of the transformed
filter at the Specify desired frequency location to be the same as the
response at the Frequency point to transform value. Thus you get a
bandpass filter whose response at the low and high frequency locations is the
same. Notice that the passband between them is undefined. In the next two
figures you see the original highpass filter and the transformed bandpass
filter.

For more information about transforming filters, refer to Chapter 3, “Digital
Frequency Transformations”.

Transformed Filter Type
Select the magnitude response for the target filter from the list. The complete
list of transformed filter types is:

• Lowpass

• Lowpass (FIR)

• Highpass

• Highpass (FIR) narrowband

• Highpass (FIR) wideband
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• Bandpass

• Bandstop

• Multiband

• Bandpass (complex)

• Bandstop (complex)

• Multiband (complex)

Not all types of transformed filters are available for all filter types on the
Original filter types list. You can transform bandpass filters only to
bandpass filters. Or bandstop filters to bandstop filters. Or IIR filters to
IIR filters.

For more information about transforming filters, refer to “Frequency
Transformations for Real Filters” on page 3-11 and “Frequency
Transformations for Complex Filters” on page 3-26.

Specify Desired Frequency Location
The frequency point you enter in Frequency point to transform matched
a magnitude response value. At each frequency you enter here, the
transformation tries to make the magnitude response the same as the
response identified by your Frequency point to transform value.

While you can enter any location, generally you should specify a filter
passband or stopband edge, or a value in the passband or stopband.

For more information about transforming filters, refer to Chapter 3, “Digital
Frequency Transformations”.

Example — Transform Filters
To transform the magnitude response of your filter, use the Transform
Filter option on the side bar.

1 Design or import your filter into FDATool.

2 Click Transform Filter, , on the side bar.

4-62



Transforming Filters

FDATool opens the Transform Filter panel in FDATool.

3 From the Original filter type list, select the response form of the filter
you are transforming.

When you select the type, whether is lowpass, highpass, bandpass, or
bandstop, FDATool recognizes whether your filter form is FIR or IIR.
Using both your filter type selection and the filter form, FDATool adjusts
the entries on the Transformed filter type list to show only those that
apply to your original filter.

4 Enter the frequency point to transform value in Frequency point to
transform. Notice that the value you enter must be in KHz; for example,
enter 0.1 for 100 Hz or 1.5 for 1500 Hz.

5 From the Transformed filter type list, select the type of filter you want
to transform to.

Your filter type selection changes the options here.

• When you pick a lowpass or highpass filter type, you enter one value in
Specify desired frequency location.

• When you pick a bandpass or bandstop filter type, you enter two values
— one in Specify desired low frequency location and one in Specify
desired high frequency location. Your values define the edges of
the passband or stopband.
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• When you pick a multiband filter type, you enter values as elements in a
vector in Specify a vector or desired frequency locations — one element
for each desired location. Your values define the edges of the passbands
and stopbands.

After you click Transform Filter, FDATool transforms your filter,
displays the magnitude response of your new filter, and updates the
Current Filter Information to show you that your filter has been
transformed. In the filter information, the Source is Transformed.

For example, the figure shown here includes the magnitude response
curves for two filter. The original filter is a lowpass filter with rolloff
between 0.2 and 0.25. The transformed filter is a lowpass filter with
rolloff region between 0.8 and 0.85.
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• To transform your lowpass filter to a highpass filter, select Lowpass to
Highpass.

When you select Lowpass to Highpass, FDATool returns the dialog
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box shown here. More information about the Select Transform...
dialog box follows the figure.

To demonstrate the effects of selecting Narrowband Highpass or
Wideband Highpass, the next figure presents the magnitude response
curves for a source lowpass filter after it is transformed to both narrow-
and wideband highpass filters. For comparison, the response of the
original filter appears as well.
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For the narrowband case, the transformation algorithm essentially
reverses the magnitude response, like reflecting the curve around the
y-axis, then translating the curve to the right until the origin lies at 1
on the x-axis. After reflecting and translating, the passband at high
frequencies is the reverse of the passband of the original filter at low
frequencies with the same rolloff and ripple characteristics.
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Designing Multirate Filters in FDATool

In this section...

“Introduction” on page 4-67

“Switching FDATool to Multirate Filter Design Mode” on page 4-67

“Controls on the Multirate Design Panel” on page 4-68

“Quantizing Multirate Filters” on page 4-78

“Exporting the Individual Phase Coefficients of a Polyphase Filter to the
Workspace” on page 4-80

Introduction
Not only can you design multirate filters from the MATLAB command prompt,
FDATool provides the same design capability in a graphical user interface
tool. By starting FDATool and switching to the multirate filter design mode
you have access to all of the multirate design capabilities in the toolbox —
decimators, interpolators, and fractional rate changing filters, among others.

Switching FDATool to Multirate Filter Design Mode
The multirate filter design mode in FDATool lets you specify and design a
wide range of multirate filters, including decimators and interpolators.

With FDATool open, click Create a Multirate Filter, , on the side bar.
You see FDATool switch to the design mode showing the multirate filter
design options. Shown in the following figure is the default multirate design
configuration that designs an interpolating filter with an interpolation factor
of 2. The design uses the current FIR filter in FDATool.
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When the current filter in FDATool is not an FIR filter, the multirate filter
design panel removes the Use current FIR filter option and selects the Use
default Nyquist FIR filter option instead as the default setting.

Controls on the Multirate Design Panel
You see the options that allow you to design a variety of multirate filters. The
Type option is your starting point. From this list you select the multirate
filter to design. Based on your selection, other options change to provide the
controls you need to specify your filter.
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Notice the separate sections of the design panel. On the left is the filter type
area where you choose the type of multirate filter to design and set the filter
performance specifications.

In the center section FDATool provides choices that let you pick the filter
design method to use.

The rightmost section offers options that control filter configuration when you
select Cascaded-Integrator Comb (CIC) as the design method in the center
section. Both the Decimator type and Interpolator type filters let you use
the Cascaded-Integrator Comb (CIC) option to design multirate filters.

Here are all the options available when you switch to multirate filter design
mode. Each option listed includes a brief description of what the option does
when you use it.

Selecting and Configuring Your Filter

Option Description

Type Specifies the type of multirate filter to design.
Choose from Decimator, Interpolator, or
Fractional-rate convertor.

• When you choose Decimator, set Decimation
Factor to specify the decimation to apply.

• When you choose Interpolator, set
Interpolation Factor to specify the
interpolation amount applied.

• When you choose Fractional-rate convertor,
set both Interpolation Factor and Decimation
Factor. FDATool uses both to determine the
fractional rate change by dividing Interpolation
Factor by Decimation Factor to determine
the fractional rate change in the signal. You
should select values for interpolation and
decimation that are relatively prime. When
your interpolation factor and decimation factor
are not relatively prime, FDATool reduces
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Selecting and Configuring Your Filter (Continued)

Option Description

the interpolation/decimation fractional rate to
the lowest common denominator and issues
a message in the status bar in FDATool. For
example, if the interpolation factor is 6 and the
decimation factor is 3, FDATool reduces 6/3 to
2/1 when you design the rate changer. But if the
interpolation factor is 8 and the decimation factor
is 3, FDATool designs the filter without change.

Interpolation
Factor

Use the up-down control arrows to specify the
amount of interpolation to apply to the signal.
Factors range upwards from 2.

Decimation Factor Use the up-down control arrows to specify the
amount of decimation to apply to the signal. Factors
range upwards from 2.

Sampling
Frequency

No settings here. Just Units and Fs below.

Units Specify whether Fs is specified in Hz, kHz, MHz, GHz,
or Normalized (0 to 1) units.

Fs Set the full scale sampling frequency in the
frequency units you specified in Units. When you
select Normalized for Units, you do not enter a
value for Fs.

Designing Your Filter

Option Description

Use current FIR
filter

Directs FDATool to use the current FIR filter to
design the multirate filter. If the current filter is an
IIR form, you cannot select this option. You cannot
design multirate filters with IIR structures.

4-70



Designing Multirate Filters in FDATool

Designing Your Filter (Continued)

Option Description

Use a default
Nyquist Filter

Tells FDATool to use the default Nyquist design
method when the current filter in FDATool is not
an FIR filter.

Cascaded
Integrator-Comb
(CIC)

Design CIC filters using the options provided in the
right-hand area of the multirate design panel.

Hold Interpolator
(Zero-order)

When you design an interpolator, you can specify
how the filter sets interpolated values between
signal values. When you select this option, the
interpolator applies the most recent signal value for
each interpolated value until it processes the next
signal value. This is similar to sample-and-hold
techniques. Compare to the Linear Interpolator
option.

Linear Interpolator
(First-order)

When you design an interpolator, you can specify
how the filter sets interpolated values between
signal values. When you select this option, the
interpolator applies linear interpolation between
signal value to set the interpolated value until it
processes the next signal value. Compare to the
Linear Interpolator option.

To see the difference between hold interpolation and linear interpolation, the
following figure presents a sine wave signal s1 in three forms:

• The top subplot in the figure presents signal s1 without interpolation.

• The middle subplot shows signal s1 interpolated by a linear interpolator
with an interpolation factor of 5.

• The bottom subplot shows signal s1 interpolated by a hold interpolator with
an interpolation factor of 5.

You see in the bottom figure the sample and hold nature of hold interpolation,
and the first-order linear interpolation applied by the linear interpolator.
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We used FDATool to create interpolators similar to the following code for
the figure:

• Linear interpolator — hm=mfilt.linearinterp(5)

• Hold interpolator — hm=mfilt.holdinterp(5)

Options for Designing CIC
Filters Description

Differential Delay Sets the differential delay for the CIC filter. Usually a value
of one or two is appropriate.

Number of Sections Specifies the number of sections in a CIC decimator. The default
number of sections is 2 and the range is any positive integer.
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Example — Design a Fractional Rate Convertor
To introduce the process you use to design a multirate filter in FDATool, this
example uses the options to design a fractional rate convertor which uses
7/3 as the fractional rate. Begin the design by creating a default lowpass
FIR filter in FDATool. You do not have to begin with this FIR filter, but
the default filter works fine.

1 Launch FDATool.

2 Select the settings for a minimum-order lowpass FIR filter, using the
Equiripple design method.

3 When FDATool displays the magnitude response for the filter, click in
the side bar. FDATool switches to multirate filter design mode, showing
the multirate design panel, shown in the following figure.
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4 To design a fractional rate filter, select Fractional-rate convertor
from the Type list. The Interpolation Factor and Decimation Factor
options become available.

5 In Interpolation Factor, use the up arrow to set the interpolation factor
to 7.

6 Using the up arrow in Decimation Factor, set 3 as the decimation factor.

7 Select Use a default Nyquist FIR filter. You could design the rate
convertor with the current FIR filter as well.
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8 Enter 24000 to set Fs.

9 Click Create Multirate Filter.

After designing the filter, FDATool returns with the specifications for
your new filter displayed in Current Filter Information, and shows
the magnitude response of the filter.

You can test the filter by exporting it to your workspace and using it to filter
a signal. For information about exporting filters, refer to “Importing and
Exporting Quantized Filters” on page 4-50.
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Example — Design a CIC Decimator for 8 Bit Input/Output Data
Another kind of filter you can design in FDATool is Cascaded-Integrator
Comb (CIC) filters. FDATool provides the options needed to configure your
CIC to meet your needs.

1 Launch FDATool and design the default FIR lowpass filter. Designing a
filter at this time is an optional step.

2 Switch FDATool to multirate design mode by clicking on the side bar.

3 For Type, select Decimator, and set Decimation Factor to 3.

4 To design the decimator using a CIC implementation, select
Cascaded-Integrator Comb (CIC). This enables the CIC-related options
on the right of the panel.

5 Set Differential Delay to 2. Generally, 1 or 2 are good values to use.

6 Enter 2 for the Number of Sections. Settings in the multirate design
panel should look like this.

7 Click Create Multirate Filter.

FDATool designs the filter, shows the magnitude response in the analysis
area, and updates the current filter information to show that you designed
a tenth-order cascaded-integrator comb decimator with two sections. Notice
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the source is Multirate Design, indicating you used the multirate design
mode in FDATool to make the filter. FDATool should look like this now.

Designing other multirate filters follows the same pattern.

To design other multirate filters, do one of the following depending on the
filter to design:

• To design an interpolator, select one of these options.

- Use a default Nyquist FIR filter

- Cascaded-Integrator Comb (CIC)
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- Hold Interpolator (Zero-order)

- Linear Interpolator (First-order)

• To design a decimator, select from these options.

- Use a default Nyquist FIR filter

- Cascaded-Integrator Comb (CIC)

• To design a fractional-rate convertor, select Use a default Nyquist FIR
filter.

Quantizing Multirate Filters
After you design a multirate filter in FDATool, the quantization features
enable you to convert your floating-point multirate filter to fixed-point
arithmetic.

Note CIC filters are always fixed-point.

With your multirate filter as the current filter in FDATool, you can quantize
your filter and use the quantization options to specify the fixed-point
arithmetic the filter uses.

To Quantize and Configure Multirate Filters
Follow these steps to convert your multirate filter to fixed-point arithmetic
and set the fixed-point options.

1 Design or import your multirate filter and make sure it is the current filter
in FDATool.

2 Click the Set Quantization Parameters button on the side bar.

3 From the Filter Arithmetic list on the Filter Arithmetic pane, select
Fixed-point. If your filter is a CIC filter, the Fixed-point option is
enabled by default and you do not set this option.

4 In the quantization panes, set the options for your filter. Set options for
Coefficients, Input/Output, and Filter Internals.
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5 Click Apply.

When you current filter is a CIC filter, the options on the Input/Output and
Filter Internals panes change to provide specific features for CIC filters.

Input/Output
The options that specify how your CIC filter uses input and output values
are listed in the table below.

Option Name Description

Input Word Length Sets the word length used to represent the input
to a filter.

Input fraction
length

Sets the fraction length used to interpret input
values to filter.

Input range (+/-) Lets you set the range the inputs represent. You
use this instead of the Input fraction length
option to set the precision. When you enter a value
x, the resulting range is -x to x. Range must be a
positive integer.

Output word length Sets the word length used to represent the output
from a filter.

Avoid overflow Directs the filter to set the fraction length for the
input to prevent the output values from exceeding
the available range as defined by the word length.
Clearing this option lets you set Output fraction
length.

Output fraction length Sets the fraction length used to represent output
values from a filter.

Output range (+/-) Lets you set the range the outputs represent. You
use this instead of the Output fraction length
option to set the precision. When you enter a value
x, the resulting range is -x to x. Range must be a
positive integer.
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The available options change when you change the Filter precision setting.
Moving from Full to Specify all adds increasing control by enabling more
input and output word options.

Filter Internals
With a CIC filter as your current filter, the Filter precision option on the
Filter Internals pane includes modes for controlling the filter word and
fraction lengths.

There are four usage modes for this (the same mode you select for the
FilterInternals property in CIC filters at the MATLAB prompt).

• Full— All word and fraction lengths set to Bmax + 1, called Baccum by Harris
in [2]. Full Precision is the default setting.

• Minimum section word lengths — Set the section word lengths to
minimum values that meet roundoff noise and output requirements as
defined by Hogenauer in [3].

• Specify word lengths — Enables the Section word length option for
you to enter word lengths for each section. Enter either a scalar to use the
same value for every section, or a vector of values, one for each section.

• Specify all— Enables the Section fraction length option in addition
to Section word length. Now you can provide both the word and fraction
lengths for each section, again using either a scalar or a vector of values.

Exporting the Individual Phase Coefficients of a
Polyphase Filter to the Workspace
After designing a polyphase filter in Filter Design Analysis Tool (FDATool),
you can obtain the individual phase coefficients of the filter by:

1 Exporting the filter to an object in the MATLAB workspace.

2 Using the polyphase method to create a matrix of the filter’s coefficients.

Exporting the Polyphase Filter to an Object
To export a polyphase filter to an object in the MATLAB workspace, complete
the following steps.
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1 In FDATool, open the File menu and select Export.... This opens the
dialog box for exporting the filter coefficients.

2 In the Export dialog box, for Export To, selectWorkspace.

3 For Export As, select Object.

4 (Optional) For Variable Names, enter the name of the Multirate Filter
object that will be created in the MATLAB workspace.

5 Click the Export button. The multirate filter object, Hm in this example,
appears in the MATLAB workspace.
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Using polyphase() to Create a Matrix of Coefficients
To create a matrix of the filter’s coefficients, enter p=polyphase(Hm) at
the command line. The polyphase method creates a matrix, p, of filter
coefficients from the filter object, Hm. Each row of p consists of the coefficients
of an individual phase subfilter. The first row contains to the coefficients of
the first phase subfilter, the second row contains those of the second phase
subfilter, and so on.
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Realizing Filters as Simulink Subsystem Blocks

In this section...

“Introduction” on page 4-83

“About the Realize Model Panel in FDATool” on page 4-83

Introduction
After you design or import a filter in FDATool, the realize model feature
lets you create a Simulink subsystem block that implements your filter. The
generated filter subsystem block uses either the Digital Filter block or the
delay, gain, and sum blocks in Simulink. If you do not own Simulink® Fixed
Point™software, FDATool still realizes your model using blocks in fixed-point
mode from Simulink, but you cannot run any model that includes your filter
subsystem block in Simulink.

About the Realize Model Panel in FDATool
Switching FDATool to realize model mode, by clicking on the sidebar,
gives you access to the Realize Model panel and the options for realizing your
quantized filter as a Simulink subsystem block.

On the panel, as shown here, are the options provided for configuring how
FDATool realizes your model.
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Model Options
Under Model, you set options that direct FDATool where to put your new
subsystem block and what to name the block.

Destination. Tells FDATool whether to put the new block in your current
Simulink model or open a new Simulink model and add the block to that
window. Select Current model to add the block to your current model, or
select New model to create a new model for the block.

Block name. Provides FDATool with a name to assign to your block. When
you realize your filter as a subsystem, the resulting block shows the name you
enter here as the block name, positioned below the block.

Overwrite block. Directs FDATool whether to overwrite an existing block
with this block in the destination model. The result is that the new filter
realization subsystem block replaces the existing filter subsystem block.
Selecting this option replaces your existing filter realization subsystem block
with the one you create when you click Realize Model. Clearing Overwrite
block causes FDATool to create a new block in the destination model, rather
than replacing the existing block.

Build block using basic elements. You can determine how FDATool
models the specified filter using this check box. When you select this check
box, FDATool creates a subsystem block that implements your filter using
Sum, Gain, and Delay blocks. When you clear this check box, FDATool uses a
Digital Filter block to implement your filter. Filters that you realize with the
Digital Filter block accept sample-based, vector, or frame-based input.

The Build model using basic elements check box is available only when
your filter can be implemented using a Digital Filter block.

Note Filters that use only basic elements accept individual sample-based
input, not input vectors or frames. The mathematics of filtering a frame-based
input signal with a filter constructed of basic blocks involves an algebraic
loop that Simulink cannot solve. If your input data is in frames, consider
unbuffering the input, converting the frames to sample-by-sample input in
some other way, or clearing the Build block using basic elements option to
implement your filter with the Digital Filter block.
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Optimization Options
Four options enable you to tailor the way the realized model optimizes various
filter features such as delays and gains. When you open the Realize Model
panel, these options are selected by default.

Optimize for zero gains. Specify whether to remove zero-gain blocks from
the realized filter.

Optimize for unity gains. Specify whether to replace unity-gain blocks
with direct connections in the filter subsystem.

Optimize for -1 gains. Specify whether to replace negative unity-gain
blocks with a sign change at the nearest sum block in the filter.

Optimize delay chains. Specify whether to replace cascaded chains of delay
blocks with a single integer delay block to provide an equivalent delay.

Each of these options can optimize the way your filter performs in simulation
and in code you might generate from your model.

Example — Realize a Filter Using FDATool
After your quantized filter in FDATool is performing the way you want, with
your desired phase and magnitude response, and with the right coefficients
and form, follow these steps to realize your filter as a subsystem that you
can use in a Simulink model.

1 Click Realize Model on the sidebar to change FDATool to realize model
mode.

2 From the Destination list under Model, select either:

• Current model— to add the realized filter subsystem to your current
model

• New model— to open a new Simulink model window and add your filter
subsystem to the new window

3 Provide a name for your new filter subsystem in the Name field.
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4 Decide whether to overwrite an existing block with this new one, and
select or clear Overwrite block to direct FDATool which way to go —
overwrite or not.

5 Select Fixed-point blocks from the list in Block Type.

6 Select or clear the optimizations to apply.

• Optimize for zero gains — removes zero gain blocks from the model
realization

• Optimize for unity gains — replaces unity gain blocks with direct
connections to adjacent blocks

• Optimize for -1 gains — replaces negative gain blocks by a change
of sign at the nearest sum block

• Optimize delay chains— replaces cascaded delay blocks with a single
delay block that produces the equivalent gain

7 Click Realize Model to realize your quantized filter as a subsystem block
according to the settings you selected.

If you double-click the filter block subsystem created by FDATool, you see the
filter implementation in Simulink model form. Depending on the options you
chose when you realized your filter, and the filter you started with, you might
see one or more sections, or different architectures based on the form of your
quantized filter. From this point on, the subsystem filter block acts like any
other block that you use in Simulink models.

Supported Filter Structures
FDATool lets you realize discrete-time and multirate filters from the following
forms:

Structure Description

firdecim Decimators based on FIR filters

firtdecim Decimators based on transposed FIR
filters

linearinterp Linear interpolators
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Structure Description

firinterp Interpolators based on FIR filters

multirate polyphase Multirate filters

holdinterp Interpolators that use the hold
interpolation algorithm

dfilt.allpass Discrete-time filters with allpass
structure

dfilt.cascadeallpass

dfilt.cascadewdfallpass

mfilt.iirdecim Decimators based on IIR filters

mfilt.iirwdfdecim

mfilt.iirinterp Interpolators based on IIR filters

mfilt.iirwdfinterp

dfilt.wdfallpass
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Getting Help for FDATool

In this section...

“The What’s This? Option” on page 4-88

“Additional Help for FDATool” on page 4-88

The What’s This? Option
To find information on a particular option or region of the dialog box:

1 Click the What’s This? button .

Your cursor changes to .

2 Click the region or option of interest.

For example, click Turn quantization on to find out what this option does.

You can also select What’s this? from the Help menu to launch
context-sensitive help.

Additional Help for FDATool
For help about importing filters into FDATool, or for details about using
FDATool to create and analyze double-precision filters, refer to “FDATool:
A Filter Design and Analysis GUI”in your Signal Processing Toolbox
documentation.
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Introducing Adaptive Filtering
Adaptive filtering involves the changing of filter parameters (coefficients) over
time, to adapt to changing signal characteristics. Over the past three decades,
digital signal processors have made great advances in increasing speed and
complexity, and reducing power consumption. As a result, real-time adaptive
filtering algorithms are quickly becoming practical and essential for the
future of communications, both wired and wireless.

In the following sections, this guide presents an overview of adaptive filtering;
discussions of some of the common applications for adaptive filters; and
details about the adaptive filters available in the toolbox.

Listed below are the sections that cover adaptive filters in this guide. Within
each section, examples and a short discussion of the theory of the filters
introduce the adaptive filter concepts.

• “Overview of Adaptive Filters and Applications” on page 5-4 presents a
general discussion of adaptive filters and their applications.

- “System Identification” on page 5-7 — Using adaptive filters to identify
the response of an unknown system such as a communications channel
or a telephone line.

- “Inverse System Identification” on page 5-8—Using adaptive filters to
develop a filter that has a response that is the inverse of an unknown
system.

- “Noise or Interference Cancellation” on page 5-9— Performing active
noise cancellation where the filter adapts in real-time to remove noise
by keeping the error small.

- “Prediction” on page 5-9 — describes using adaptive filters to predict a
signal’s future values.

• “System Identification” on page 5-7 describes the important considerations
for selecting an adaptive filter for an application.

• “Adaptive Filters in Filter Design Toolbox Software” on page 5-11 lists the
adaptive filters included in the toolbox.
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• “Examples of Adaptive Filters That Use LMS Algorithms” on page 5-15
presents a discussion of using LMS techniques to perform the filter
adaptation process.

• “Example of Adaptive Filter That Uses RLS Algorithm” on page 5-36
discusses adaptive filters based on the RMS techniques for minimizing the
total error between the known and unknown systems.

For more detailed information about adaptive filters and adaptive filter
theory, refer to the books listed in “Selected Bibliography” on page 5-41.
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Overview of Adaptive Filters and Applications

In this section...

“Adaptive Filtering Methodology” on page 5-4

“Choosing an Adaptive Filter” on page 5-6

“System Identification” on page 5-7

“Inverse System Identification” on page 5-8

“Noise or Interference Cancellation” on page 5-9

“Prediction” on page 5-9

Adaptive Filtering Methodology
This section presents a brief description of how adaptive filters work and
some of the applications where they can be useful.

Adaptive filters self learn. As the signal into the filter continues, the adaptive
filter coefficients adjust themselves to achieve the desired result, such as
identifying an unknown filter or canceling noise in the input signal. In the
figure below, the shaded box represents the adaptive filter, comprising the
adaptive filter and the adaptive recursive least squares (RLS) algorithm.
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Block Diagram That Defines the Inputs and Output of a Generic RLS Adaptive
Filter

The next figure provides the general adaptive filter setup with inputs and
outputs.
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Block Diagram Defining General Adaptive Filter Algorithm Inputs and
Outputs

Filter Design Toolbox software includes adaptive filters of a broad range of
forms, all of which can be worthwhile for specific needs. Some of the common
ones are:

• Adaptive filters based on least mean squares (LMS) techniques, such as
adaptfilt.lms, adaptfilt.filtxlms, and adaptfilt.nlms

• Adaptive filters based on recursive least squares (RLS) techniques. For
example, adaptfilt.rls and adaptfilt.swrls

• Adaptive filters based on sign-data (adaptfilt.sd), sign-error
(adaptfilt.se), and sign-sign (adaptfilt.ss) techniques

• Adaptive filters based on lattice filters. For example, adaptfilt.gal and
adaptfilt.lsl

• Adaptive filters that operate in the frequency domain, such as
adaptfilt.fdaf and adaptfilt.pbufdaf.

• Adaptive filters that operate in the transform domain. Two of these are the
adaptfilt.tdafdft and adaptfilt.tdafdct filters

An adaptive filter designs itself based on the characteristics of the input
signal to the filter and a signal that represents the desired behavior of the
filter on its input.

Designing the filter does not require any other frequency response information
or specification. To define the self-learning process the filter uses, you select
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the adaptive algorithm used to reduce the error between the output signal
y(k) and the desired signal d(k).

When the LMS performance criterion for e(k) has achieved its minimum value
through the iterations of the adapting algorithm, the adaptive filter is finished
and its coefficients have converged to a solution. Now the output from the
adaptive filter matches closely the desired signal d(k). When you change the
input data characteristics, sometimes called the filter environment, the filter
adapts to the new environment by generating a new set of coefficients for the
new data. Notice that when e(k) goes to zero and remains there you achieve
perfect adaptation, the ideal result but not likely in the real world.

The adaptive filter functions in this toolbox implement the shaded portion of
the figures, replacing the adaptive algorithm with an appropriate technique.
To use one of the functions, you provide the input signal or signals and the
initial values for the filter.

“Adaptive Filters in Filter Design Toolbox Software” on page 5-11 offers
details about the algorithms available and the inputs required to use them
in MATLAB.

Choosing an Adaptive Filter
Selecting the adaptive filter that best meets your needs requires careful
consideration. An exhaustive discussion of the criteria for selecting your
approach is beyond the scope of this User’s Guide. However, a few guidelines
can help you make your choice.

Two main considerations frame the decision — how you plan to use the filter
and the filter algorithm to use.

When you begin to develop an adaptive filter for your needs, most likely the
primary concern is whether using an adaptive filter is a cost-competitive
approach to solving your filtering needs. Generally many areas determine the
suitability of adaptive filters (these areas are common to most filtering and
signal processing applications). Four such areas are

• Filter consistency — Does your filter performance degrade when the filter
coefficients change slightly as a result of quantization, or you switch
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to fixed-point arithmetic? Will excessive noise in the signal hurt the
performance of your filter?

• Filter performance — Does your adaptive filter provide sufficient
identification accuracy or fidelity, or does the filter provide sufficient signal
discrimination or noise cancellation to meet your requirements?

• Tools — Do tools exist that make your filter development process easier?
Better tools can make it practical to use more complex adaptive algorithms.

• DSP requirements — Can your filter perform its job within the constraints
of your application? Does your processor have sufficient memory,
throughput, and time to use your proposed adaptive filtering approach?
Can you trade memory for throughput: use more memory to reduce the
throughput requirements or use a faster signal processor?

Of the preceding considerations, characterizing filter consistency or
robustness may be the most difficult.

The simulations in Filter Design Toolbox software offers a good first step in
developing and studying these issues. LMS algorithm filters provide both a
relatively straightforward filters to implement and sufficiently powerful tool
for evaluating whether adaptive filtering can be useful for your problem.

Additionally, starting with an LMS approach can form a solid baseline against
which you can study and compare the more complex adaptive filters available
in the toolbox. Finally, your development process should, at some time, test
your algorithm and adaptive filter with real data. For truly testing the value
of your work there is no substitute for actual data.

System Identification
One common adaptive filter application is to use adaptive filters to identify
an unknown system, such as the response of an unknown communications
channel or the frequency response of an auditorium, to pick fairly divergent
applications. Other applications include echo cancellation and channel
identification.

In the figure, the unknown system is placed in parallel with the adaptive
filter. This layout represents just one of many possible structures. The shaded
area contains the adaptive filter system.
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Using an Adaptive Filter to Identify an Unknown System

Clearly, when e(k) is very small, the adaptive filter response is close to the
response of the unknown system. In this case the same input feeds both the
adaptive filter and the unknown. If, for example, the unknown system is a
modem, the input often represents white noise, and is a part of the sound you
hear from your modem when you log in to your Internet service provider.

Inverse System Identification
By placing the unknown system in series with your adaptive filter, your
filter adapts to become the inverse of the unknown system as e(k) becomes
very small. As shown in the figure the process requires a delay inserted in
the desired signal d(k) path to keep the data at the summation synchronized.
Adding the delay keeps the system causal.

Determing an Inverse Response to an Unknown System

Including the delay to account for the delay caused by the unknown system
prevents this condition.
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Plain old telephone systems (POTS) commonly use inverse system
identification to compensate for the copper transmission medium. When
you send data or voice over telephone lines, the copper wires behave like a
filter, having a response that rolls off at higher frequencies (or data rates)
and having other anomalies as well.

Adding an adaptive filter that has a response that is the inverse of the wire
response, and configuring the filter to adapt in real time, lets the filter
compensate for the rolloff and anomalies, increasing the available frequency
output range and data rate for the telephone system.

Noise or Interference Cancellation
In noise cancellation, adaptive filters let you remove noise from a signal in
real time. Here, the desired signal, the one to clean up, combines noise and
desired information. To remove the noise, feed a signal n’(k) to the adaptive
filter that represents noise that is correlated to the noise to remove from
the desired signal.

�	
����������� ���	
���

����

���� ����
�

�

������	���

����

Using an Adaptive Filter to Remove Noise from an Unknown System

So long as the input noise to the filter remains correlated to the unwanted
noise accompanying the desired signal, the adaptive filter adjusts its
coefficients to reduce the value of the difference between y(k) and d(k),
removing the noise and resulting in a clean signal in e(k). Notice that in
this application, the error signal actually converges to the input data signal,
rather than converging to zero.

Prediction
Predicting signals requires that you make some key assumptions. Assume
that the signal is either steady or slowly varying over time, and periodic over
time as well.
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Predicting Future Values of a Periodic Signal

Accepting these assumptions, the adaptive filter must predict the future
values of the desired signal based on past values. When s(k) is periodic and
the filter is long enough to remember previous values, this structure with the
delay in the input signal, can perform the prediction. You might use this
structure to remove a periodic signal from stochastic noise signals.

Finally, notice that most systems of interest contain elements of more than
one of the four adaptive filter structures. Carefully reviewing the real
structure may be required to determine what the adaptive filter is adapting to.

Also, for clarity in the figures, the analog-to-digital (A/D) and digital-to-analog
(D/A) components do not appear. Since the adaptive filters are assumed to be
digital in nature, and many of the problems produce analog data, converting
the input signals to and from the analog domain is probably necessary.
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Adaptive Filters in Filter Design Toolbox Software

In this section...

“Overview of Adaptive Filtering in Filter Design Toolbox Software” on page
5-11

“Algorithms” on page 5-11

“Using Adaptive Filter Objects” on page 5-14

Overview of Adaptive Filtering in Filter Design
Toolbox Software
Filter Design Toolbox software contains many objects for constructing and
applying adaptive filters to data. As you see in the tables in the next section,
the objects use various algorithms to determine the weights for the filter
coefficients of the adapting filter. While the algorithms differ in their detail
implementations, the LMS and RLS share a common operational approach —
minimizing the error between the filter output and the desired signal.

Algorithms
For adaptive filter (adaptfilt) objects, the algorithm string determines
which adaptive filter algorithm your adaptfilt object implements. Each
available algorithm entry appears in one of the tables along with a brief
description of the algorithm. Click on the algorithm in the first column to get
more information about the associated adaptive filter technique.

• LMS based adaptive filters

• RLS based adaptive filters

• Affine projection adaptive filters

• Adaptive filters in the frequency domain

• Lattice based adaptive filters
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Least Mean Squares (LMS) Based FIR Adaptive Filters

Adaptive Filter
Method

Adapting Algorithm Used to Generate Filter
Coefficients During Adaptation

adaptfilt.adjlms Adjoint LMS FIR adaptive filter algorithm

adaptfilt.blms Block LMS FIR adaptive filter algorithm

adaptfilt.blmsfft FFT-based Block LMS FIR adaptive filter
algorithm

adaptfilt.dlms Delayed LMS FIR adaptive filter algorithm

adaptfilt.filtxlms Filtered-x LMS FIR adaptive filter algorithm

adaptfilt.lms LMS FIR adaptive filter algorithm

adaptfilt.nlms Normalized LMS FIR adaptive filter algorithm

adaptfilt.sd Sign-data LMS FIR adaptive filter algorithm

adaptfilt.se Sign-error LMS FIR adaptive filter algorithm

adaptfilt.ss Sign-sign LMS FIR adaptive filter algorithm

For further information about an adapting algorithm, refer to the reference
page for the algorithm.

Recursive Least Squares (RLS) Based FIR Adaptive Filters

Adaptive Filter
Method

Adapting Algorithm Used to Generate Filter
Coefficients During Adaptation

adaptfilt.ftf Fast transversal least-squares adaptation algorithm

adaptfilt.qrdrls QR-decomposition RLS adaptation algorithm

adaptfilt.hrls Householder RLS adaptation algorithm

adaptfilt.hswrls Householder SWRLS adaptation algorithm

adaptfilt.rls Recursive-least squares (RLS) adaptation algorithm

adaptfilt.swrls Sliding window (SW) RLS adaptation algorithm

adaptfilt.swftf Sliding window FTF adaptation algorithm
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For more complete information about an adapting algorithm, refer to the
reference page for the algorithm.

Affine Projection (AP) FIR Adaptive Filters

Adaptive Filter
Method

Adapting Algorithm Used to Generate Filter
Coefficients During Adaptation

adaptfilt.ap Affine projection algorithm that uses direct matrix
inversion

adaptfilt.apru Affine projection algorithm that uses recursive matrix
updating

adaptfilt.bap Block affine projection adaptation algorithm

To find more information about an adapting algorithm, refer to the reference
page for the algorithm.

FIR Adaptive Filters in the Frequency Domain (FD)

Adaptive Filter
Method

Description of the Adapting Algorithm
Used to Generate Filter Coefficients During
Adaptation

adaptfilt.fdaf Frequency domain adaptation algorithm

adaptfilt.pbfdaf Partition block version of the FDAF algorithm

adaptfilt.pbufdaf Partition block unconstrained version of the FDAF
algorithm

adaptfilt.tdafdct Transform domain adaptation algorithm using
DCT

adaptfilt.tdafdft Transform domain adaptation algorithm using
DFT

adaptfilt.ufdaf Unconstrained FDAF algorithm for adaptation

For more information about an adapting algorithm, refer to the reference
page for the algorithm.

5-13



5 Adaptive Filters

Lattice-Based (L) FIR Adaptive Filters

Adaptive Filter
Method

Description of the Adapting Algorithm Used to
Generate Filter Coefficients During Adaptation

adaptfilt.gal Gradient adaptive lattice filter adaptation algorithm

adaptfilt.lsl Least squares lattice adaptation algorithm

adaptfilt.qrdlsl QR decomposition RLS adaptation algorithm

For more information about an adapting algorithm, refer to the reference
page for the algorithm.

Presenting a detailed derivation of the Wiener-Hopf equation and determining
solutions to it is beyond the scope of this User’s Guide. Full descriptions of
the theory appear in the adaptive filter references provided in the “Selected
Bibliography” on page 5-41.

Using Adaptive Filter Objects
After you construct an adaptive filter object, how do you apply it to your data
or system? Like quantizer objects, adaptive filter objects have a filter
method that you use to apply the adaptfilt object to data. In the following
sections, various examples of using LMS and RLS adaptive filters show you
how filter works with the objects to apply them to data.

• “Examples of Adaptive Filters That Use LMS Algorithms” on page 5-15

• “Example of Adaptive Filter That Uses RLS Algorithm” on page 5-36

5-14



Examples of Adaptive Filters That Use LMS Algorithms

Examples of Adaptive Filters That Use LMS Algorithms

In this section...

“LMS Methods Available in Filter Design Toolbox Software” on page 5-15

“adaptfilt.lms Example — System Identification” on page 5-17

“adaptfilt.nlms Example — System Identification” on page 5-20

“adaptfilt.sd Example — Noise Cancellation” on page 5-23

“adaptfilt.se Example — Noise Cancellation” on page 5-27

“adaptfilt.ss Example — Noise Cancellation” on page 5-32

LMS Methods Available in Filter Design Toolbox
Software
This section provides introductory examples using some of the least mean
squares (LMS) adaptive filter functions in the toolbox.

The toolbox provides many adaptive filter design functions that use the LMS
algorithms to search for the optimal solution to the adaptive filter, including

• adaptfilt.lms— Implement the LMS algorithm to solve the Wiener-Hopf
equation and find the filter coefficients for an adaptive filter.

• adaptfilt.nlms — Implement the normalized variation of the LMS
algorithm to solve the Wiener-Hopf equation and determine the filter
coefficients of an adaptive filter.

• adaptfilt.sd— Implement the sign-data variation of the LMS algorithm
to solve the Wiener-Hopf equation and determine the filter coefficients of
an adaptive filter. The correction to the filter weights at each iteration
depends on the sign of the input x(k).

• adaptfilt.se— Implement the sign-error variation of the LMS algorithm
to solve the Wiener-Hopf equation and determine the filter coefficients of
an adaptive filter. The correction applied to the current filter weights for
each successive iteration depends on the sign of the error, e(k).

• adaptfilt.ss— Implement the sign-sign variation of the LMS algorithm
to solve the Wiener-Hopf equation and determine the filter coefficients of an
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adaptive filter. The correction applied to the current filter weights for each
successive iteration depends on both the sign of x(k) and the sign of e(k).

To demonstrate the differences and similarities among the various LMS
algorithms supplied in the toolbox, the LMS and NLMS adaptive filter
examples use the same filter for the unknown system. The unknown filter is
the constrained lowpass filter from firgr and fircband examples.

[b,err,res]=firgr(12,[0 0.4 0.5 1], [1 1 0 0], [1 0.2],...
{'w' 'c'});

From the figure you see that the filter is indeed lowpass and constrained to
0.2 ripple in the stopband. With this as the baseline, the adaptive LMS filter
examples use the adaptive LMS algorithms and their initialization functions
to identify this filter in a system identification role.

To review the general model for system ID mode, look at “System
Identification” on page 5-7 for the layout.
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For the sign variations of the LMS algorithm, the examples use noise
cancellation as the demonstration application, as opposed to the system
identification application used in the LMS examples.

adaptfilt.lms Example — System Identification
To use the adaptive filter functions in the toolbox you need to provide three
things:

• The adaptive LMS function to use. This example uses the LMS adaptive
filter function adaptfilt.lms.

• An unknown system or process to adapt to. In this example, the filter
designed by firgr is the unknown system.

• Appropriate input data to exercise the adaptation process. In terms of
the generic LMS model, these are the desired signal d(k) and the input
signal x(k).

Start by defining an input signal x.

x = 0.1*randn(1,250);

The input is broadband noise. For the unknown system filter, use firgr to
create a twelfth-order lowpass filter:

[b,err,res] = firgr(12,[0 0.4 0.5 1],[1 1 0 0],[1 0.2],{'w','c'});

Although you do not need them here, include the err and res output
arguments.

Now filter the signal through the unknown system to get the desired signal.

d = filter(b,1,x);

With the unknown filter designed and the desired signal in place you
construct and apply the adaptive LMS filter object to identify the unknown.

Preparing the adaptive filter object requires that you provide starting values
for estimates of the filter coefficients and the LMS step size. You could start
with estimated coefficients of some set of nonzero values; this example uses
zeros for the 12 initial filter weights.
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For the step size, 0.8 is a reasonable value — a good compromise between
being large enough to converge well within the 250 iterations (250 input
sample points) and small enough to create an accurate estimate of the
unknown filter.

mu = 0.8;
ha = adaptfilt.lms(13,mu);

Finally, using the adaptfilt object ha, desired signal, d, and the input to the
filter, x, run the adaptive filter to determine the unknown system and plot
the results, comparing the actual coefficients from firgr to the coefficients
found by adaptlms.

[y,e] = filter(ha,x,d);
stem([b.' ha.coefficients.'])
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In the stem plot the actual and estimated filter weights are the same. As an
experiment, try changing the step size to 0.2. Repeating the example with
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mu = 0.2 results in the following stem plot. The estimated weights fail to
approximate the actual weights closely.
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Since this may be because you did not iterate over the LMS algorithm enough
times, try using 1000 samples. With 1000 samples, the stem plot, shown
in the next figure, looks much better, albeit at the expense of much more
computation. Clearly you should take care to select the step size with both the
computation required and the fidelity of the estimated filter in mind.
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adaptfilt.nlms Example — System Identification
To improve the convergence performance of the LMS algorithm, the
normalized variant (NLMS) uses an adaptive step size based on the signal
power. As the input signal power changes, the algorithm calculates the input
power and adjusts the step size to maintain an appropriate value. Thus the
step size changes with time.

As a result, the normalized algorithm converges more quickly with fewer
samples in many cases. For input signals that change slowly over time, the
normalized LMS can represent a more efficient LMS approach.

In the adaptlms example, you used firgr to create the filter that you would
identify. So you can compare the results, you use the same filter, and replace
adaptlms with adaptnlms, to use the normalized LMS algorithm variation.
You should see better convergence with similar fidelity.
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First, generate the input signal and the unknown filter.

x = 0.1*randn(1,500);
[b,err,res] = fircband(12,[0 0.4 0.5 1], [1 1 0 0], [1 0.2],...
{'w' 'c'});
d = filter(b,1,x);

Again d represents the desired signal d(x) as you defined it earlier and b
contains the filter coefficients for your unknown filter.

mu = 0.8;
ha = adaptfilt.nlms(13,mu);

You use the preceding code to initialize the normalized LMS algorithm.
For more information about the optional input arguments, refer to
adaptfilt.nlms in the reference section of this User’s Guide.

Running the system identification process is a matter of using
adaptfilt.nlms with the desired signal, the input signal, and the initial
filter coefficients and conditions specified in s as input arguments. Then plot
the results to compare the adapted filter to the actual filter.

[y,e] = filter(ha,x,d);
stem([b.' ha.coefficients.'])

As shown in the following stem plot (a convenient way to compare the
estimated and actual filter coefficients), the two are nearly identical.

5-21



5 Adaptive Filters

0 2 4 6 8 10 12 14
−0.1

0

0.1

0.2

0.3

0.4

0.5

0.6
System Identification by Normalized LMS Algorithm

Actual Filter Weights
Estimated Filter Weights

If you compare the convergence performance of the regular LMS algorithm to
the normalized LMS variant, you see the normalized version adapts in far
fewer iterations to a result almost as good as the nonnormalized version.
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adaptfilt.sd Example — Noise Cancellation
When the amount of computation required to derive an adaptive filter
drives your development process, the sign-data variant of the LMS (SDLMS)
algorithm may be a very good choice as demonstrated in this example.

Fortunately, the current state of digital signal processor (DSP) design has
relaxed the need to minimize the operations count by making DSPs whose
multiply and shift operations are as fast as add operations. Thus some of
the impetus for the sign-data algorithm (and the sign-error and sign-sign
variations) has been lost to DSP technology improvements.

In the standard and normalized variations of the LMS adaptive filter,
coefficients for the adapting filter arise from the mean square error between
the desired signal and the output signal from the unknown system. Using the
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sign-data algorithm changes the mean square error calculation by using the
sign of the input data to change the filter coefficients.

When the error is positive, the new coefficients are the previous coefficients
plus the error multiplied by the step size µ. If the error is negative, the new
coefficients are again the previous coefficients minus the error multiplied
by µ — note the sign change.

When the input is zero, the new coefficients are the same as the previous set.

In vector form, the sign-data LMS algorithm is

,

with vector w containing the weights applied to the filter coefficients and
vector x containing the input data. e(k) (equal to desired signal - filtered
signal) is the error at time k and is the quantity the SDLMS algorithm seeks
to minimize. µ (mu) is the step size.

As you specify mu smaller, the correction to the filter weights gets smaller
for each sample and the SDLMS error falls more slowly. Larger mu changes
the weights more for each step so the error falls more rapidly, but the
resulting error does not approach the ideal solution as closely. To ensure good
convergence rate and stability, select mu within the following practical bounds

where N is the number of samples in the signal. Also, define mu as a power of
two for efficient computing.
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Note How you set the initial conditions of the sign-data algorithm profoundly
influences the effectiveness of the adaptation. Because the algorithm
essentially quantizes the input signal, the algorithm can become unstable
easily.

A series of large input values, coupled with the quantization process may
result in the error growing beyond all bounds. You restrain the tendency of
the sign-data algorithm to get out of control by choosing a small step size (µ<<
1) and setting the initial conditions for the algorithm to nonzero positive
and negative values.

In this noise cancellation example, adaptfilt.sd requires two input data
sets:

• Data containing a signal corrupted by noise. In Using an Adaptive Filter
to Remove Noise from an Unknown System on page 5-9, this is d(k), the
desired signal. The noise cancellation process removes the noise, leaving
the signal.

• Data containing random noise (x(k) in Using an Adaptive Filter to Remove
Noise from an Unknown System on page 5-9) that is correlated with the
noise that corrupts the signal data. Without the correlation between the
noise data, the adapting algorithm cannot remove the noise from the signal.

For the signal, use a sine wave. Note that signal is a column vector of 1000
elements.

signal = sin(2*pi*0.055*[0:1000-1]');

Now, add correlated white noise to signal. To ensure that the noise is
correlated, pass the noise through a lowpass FIR filter, and then add the
filtered noise to the signal.

noise=randn(1,1000);
nfilt=fir1(11,0.4); % Eleventh order lowpass filter
fnoise=filter(nfilt,1,noise); % Correlated noise data
d=signal.'+fnoise;
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fnoise is the correlated noise and d is now the desired input to the sign-data
algorithm.

To prepare the adaptfilt object for processing, set the input conditions
coeffs and mu for the object. As noted earlier in this section, the values you
set for coeffs and mu determine whether the adaptive filter can remove the
noise from the signal path.

In “adaptfilt.lms Example — System Identification” on page 5-17, you
constructed a default filter that sets the filter coefficients to zeros. In most
cases that approach does not work for the sign-data algorithm. The closer you
set your initial filter coefficients to the expected values, the more likely it is
that the algorithm remains well behaved and converges to a filter solution
that removes the noise effectively.

For this example, start with the coefficients in the filter you used to filter the
noise (nfilt), and modify them slightly so the algorithm has to adapt.

coeffs = nfilt.' -0.01; % Set the filter initial conditions.
mu = 0.05; % Set the step size for algorithm updating.

With the required input arguments for adaptfilt.sd prepared, construct the
adaptfilt object, run the adaptation, and view the results.

ha = adaptfilt.sd(12,mu)
set(ha,'coefficients',coeffs);
[y,e] = filter(ha,noise,d);
plot(0:199,signal(1:200),0:199,e(1:200));

When adaptfilt.sd runs, it uses far fewer multiply operations than either of
the LMS algorithms. Also, performing the sign-data adaptation requires only
bit shifting multiplies when the step size is a power of two.

Although the performance of the sign-data algorithm as shown in the next
figure is quite good, the sign-data algorithm is much less stable than the
standard LMS variations. In this noise cancellation example, the signal after
processing is a very good match to the input signal, but the algorithm could
very easily grow without bound rather than achieve good performance.
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Changing coeffs, mu, or even the lowpass filter you used to create the
correlated noise can cause noise cancellation to fail and the algorithm to
become useless.
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adaptfilt.se Example — Noise Cancellation
In some cases, the sign-error variant of the LMS algorithm (SELMS) may be a
very good choice for an adaptive filter application.

In the standard and normalized variations of the LMS adaptive filter, the
coefficients for the adapting filter arise from calculating the mean square
error between the desired signal and the output signal from the unknown
system, and applying the result to the current filter coefficients. Using the
sign-error algorithm replaces the mean square error calculation by using the
sign of the error to modify the filter coefficients.
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When the error is positive, the new coefficients are the previous coefficients
plus the error multiplied by the step size µ. If the error is negative, the new
coefficients are again the previous coefficients minus the error multiplied by
µ — note the sign change. When the input is zero, the new coefficients are
the same as the previous set.

In vector form, the sign-error LMS algorithm is

,

with vector w containing the weights applied to the filter coefficients and
vector x containing the input data. e(k) (equal to desired signal - filtered
signal) is the error at time k and is the quantity the SELMS algorithm seeks
to minimize. µ (mu) is the step size. As you specify mu smaller, the correction
to the filter weights gets smaller for each sample and the SELMS error falls
more slowly.

Larger mu changes the weights more for each step so the error falls more
rapidly, but the resulting error does not approach the ideal solution as closely.
To ensure good convergence rate and stability, select mu within the following
practical bounds

where N is the number of samples in the signal. Also, define mu as a power of
two for efficient computation.
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Note How you set the initial conditions of the sign-data algorithm profoundly
influences the effectiveness of the adaptation. Because the algorithm
essentially quantizes the error signal, the algorithm can become unstable
easily.

A series of large error values, coupled with the quantization process may
result in the error growing beyond all bounds. You restrain the tendency of
the sign-error algorithm to get out of control by choosing a small step size
(µ<< 1) and setting the initial conditions for the algorithm to nonzero positive
and negative values.

In this noise cancellation example, adaptfilt.se requires two input data
sets:

• Data containing a signal corrupted by noise. In Using an Adaptive Filter
to Remove Noise from an Unknown System on page 5-9, this is d(k), the
desired signal. The noise cancellation process removes the noise, leaving
the signal.

• Data containing random noise (x(k) in Using an Adaptive Filter to Remove
Noise from an Unknown System on page 5-9) that is correlated with the
noise that corrupts the signal data. Without the correlation between the
noise data, the adapting algorithm cannot remove the noise from the signal.

For the signal, use a sine wave. Note that signal is a column vector of 1000
elements.

signal = sin(2*pi*0.055*[0:1000-1]');

Now, add correlated white noise to signal. To ensure that the noise is
correlated, pass the noise through a lowpass FIR filter, then add the filtered
noise to the signal.

noise=randn(1,1000);
nfilt=fir1(11,0.4); % Eleventh order lowpass filter.
fnoise=filter(nfilt,1,noise); % Correlated noise data.
d=signal.'+fnoise;
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fnoise is the correlated noise and d is now the desired input to the sign-data
algorithm.

To prepare the adaptfilt object for processing, set the input conditions
coeffs and mu for the object. As noted earlier in this section, the values you
set for coeffs and mu determine whether the adaptive filter can remove
the noise from the signal path. In “adaptfilt.lms Example — System
Identification” on page 5-17, you constructed a default filter that sets the filter
coefficients to zeros.

Setting the coefficients to zero often does not work for the sign-error
algorithm. The closer you set your initial filter coefficients to the expected
values, the more likely it is that the algorithm remains well behaved and
converges to a filter solution that removes the noise effectively.

For this example, you start with the coefficients in the filter you used to filter
the noise (nfilt), and modify them slightly so the algorithm has to adapt.

coeffs = nfilt.' -0.01; % Set the filter initial conditions.
mu = 0.05; % Set step size for algorithm update.

With the required input arguments for adaptfilt.se prepared, run the
adaptation and view the results.

ha = adaptfilt.sd(12,mu)
set(ha,'coefficients',coeffs);
set(ha,'persistentmemory',true); % Prevent filter reset.
[y,e] = filter(ha,noise,d);
plot(0:199,signal(1:200),0:199,e(1:200));

Notice that you have to set the property PersistentMemory to true when you
manually change the settings of object ha.

If PersistentMemory is left to false, the default, when you try to apply
ha with the method filter, the filtering process starts by resetting the
object properties to their initial conditions at construction. To preserve the
customized coefficients in this example, you set PersistentMemory to true so
the coefficients do not get reset automatically back to zero.
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When adaptfilt.se runs, it uses far fewer multiply operations than either of
the LMS algorithms. Also, performing the sign-error adaptation requires only
bit shifting multiplies when the step size is a power of two.

Although the performance of the sign-data algorithm as shown in the next
figure is quite good, the sign-data algorithm is much less stable than the
standard LMS variations. In this noise cancellation example, the signal after
processing is a very good match to the input signal, but the algorithm could
very easily become unstable rather than achieve good performance.

Changing coeffs, mu, or even the lowpass filter you used to create the
correlated noise can cause noise cancellation to fail and the algorithm to
become useless.

0 20 40 60 80 100 120 140 160 180 200
−2.5

−2

−1.5

−1

−0.5

0

0.5

1

1.5

2
Noise Cancellation Performance by the Sign−Error LMS Algorithm

Sample Number

E
rr

or
 V

al
ue

Actual Signal
Error After Noise Reduction

5-31



5 Adaptive Filters

adaptfilt.ss Example — Noise Cancellation
One more example of a variation of the LMS algorithm in the toolbox is the
sign-sign variant (SSLMS). The rationale for this version matches those for
the sign-data and sign-error algorithms presented in preceding sections. For
more details, refer to “adaptfilt.sd Example — Noise Cancellation” on page
5-23.

The sign-sign algorithm (SSLMS) replaces the mean square error calculation
with using the sign of the input data to change the filter coefficients. When
the error is positive, the new coefficients are the previous coefficients plus the
error multiplied by the step size µ.

If the error is negative, the new coefficients are again the previous coefficients
minus the error multiplied by µ — note the sign change. When the input is
zero, the new coefficients are the same as the previous set.

In essence, the algorithm quantizes both the error and the input by applying
the sign operator to them.

In vector form, the sign-sign LMS algorithm is

,

where

Vector w contains the weights applied to the filter coefficients and vector x
contains the input data. e(k) ( = desired signal - filtered signal) is the error at
time k and is the quantity the SSLMS algorithm seeks to minimize. µ(mu) is
the step size. As you specify mu smaller, the correction to the filter weights
gets smaller for each sample and the SSLMS error falls more slowly.

Larger mu changes the weights more for each step so the error falls more
rapidly, but the resulting error does not approach the ideal solution as closely.
To ensure good convergence rate and stability, select mu within the following
practical bounds
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where N is the number of samples in the signal. Also, define mu as a power of
two for efficient computation.

Note How you set the initial conditions of the sign-sign algorithm profoundly
influences the effectiveness of the adaptation. Because the algorithm
essentially quantizes the input signal and the error signal, the algorithm
can become unstable easily.

A series of large error values, coupled with the quantization process may
result in the error growing beyond all bounds. You restrain the tendency of
the sign-sign algorithm to get out of control by choosing a small step size (µ<<
1) and setting the initial conditions for the algorithm to nonzero positive
and negative values.

In this noise cancellation example, adaptfilt.ss requires two input data
sets:

• Data containing a signal corrupted by noise. In Using an Adaptive Filter
to Remove Noise from an Unknown System on page 5-9, this is d(k), the
desired signal. The noise cancellation process removes the noise, leaving
the cleaned signal as the content of the error signal.

• Data containing random noise (x(k) in Using an Adaptive Filter to Remove
Noise from an Unknown System on page 5-9) that is correlated with the
noise that corrupts the signal data, called. Without the correlation between
the noise data, the adapting algorithm cannot remove the noise from the
signal.

For the signal, use a sine wave. Note that signal is a column vector of 1000
elements.

signal = sin(2*pi*0.055*[0:1000-1]');

Now, add correlated white noise to signal. To ensure that the noise is
correlated, pass the noise through a lowpass FIR filter, then add the filtered
noise to the signal.
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noise=randn(1,1000);
nfilt=fir1(11,0.4); % Eleventh order lowpass filter
fnoise=filter(nfilt,1,noise); % Correlated noise data
d=signal.'+fnoise;

fnoise is the correlated noise and d is now the desired input to the sign-data
algorithm.

To prepare the adaptfilt object for processing, set the input conditions
coeffs and mu for the object. As noted earlier in this section, the values you set
for coeffs and mu determine whether the adaptive filter can remove the noise
from the signal path. In “adaptfilt.lms Example — System Identification” on
page 5-17, you constructed a default filter that sets the filter coefficients to
zeros. Usually that approach does not work for the sign-sign algorithm.

The closer you set your initial filter coefficients to the expected values, the
more likely it is that the algorithm remains well behaved and converges to a
filter solution that removes the noise effectively. For this example, you start
with the coefficients in the filter you used to filter the noise (nfilt), and
modify them slightly so the algorithm has to adapt.

coeffs = nfilt.' -0.01; % Set the filter initial conditions.
mu = 0.05; % Set the step size for algorithm updating.

With the required input arguments for adaptfilt.ss prepared, run the
adaptation and view the results.

ha = adaptfilt.ss(12,mu)
set(ha,'coefficients',coeffs);
set(ha,'persistentmemory',true); % Prevent filter reset.
[y,e] = filter(ha,noise,d);
plot(0:199,signal(1:200),0:199,e(1:200));

Notice that you have to set the property PersistentMemory to true when you
manually change the settings of object ha.

If PersistentMemory is left to false, when you try to apply ha with the
method filter the filtering process starts by resetting the object properties to
their initial conditions at construction. To preserve the customized coefficients
in this example, you set PersistentMemory to true so the coefficients do not
get reset automatically back to zero.
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When adaptfilt.ss runs, it uses far fewer multiply operations than either of
the LMS algorithms. Also, performing the sign-sign adaptation requires only
bit shifting multiplies when the step size is a power of two.

Although the performance of the sign-sign algorithm as shown in the next
figure is quite good, the sign-sign algorithm is much less stable than the
standard LMS variations. In this noise cancellation example, the signal after
processing is a very good match to the input signal, but the algorithm could
very easily become unstable rather than achieve good performance.

Changing coeffs, mu, or even the lowpass filter you used to create the
correlated noise can cause noise cancellation to fail and the algorithm to
become useless.
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As an aside, the sign-sign LMS algorithm is part of the international CCITT
standard for 32 Kb/s ADPCM telephony.
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Example of Adaptive Filter That Uses RLS Algorithm

In this section...

“Introduction and Comparison to the LMS Algorithm” on page 5-36

“adaptfilt.rls Example — Inverse System Identification” on page 5-37

Introduction and Comparison to the LMS Algorithm
This section provides an introductory example that uses the RLS adaptive
filter function adaptfilt.rls.

If LMS algorithms represent the simplest and most easily applied adaptive
algorithms, the recursive least squares (RLS) algorithms represents increased
complexity, computational cost, and fidelity. In performance, RLS approaches
the Kalman filter in adaptive filtering applications, at somewhat reduced
required throughput in the signal processor.

Compared to the LMS algorithm, the RLS approach offers faster convergence
and smaller error with respect to the unknown system, at the expense of
requiring more computations.

In contrast to the least mean squares algorithm, from which it can be derived,
the RLS adaptive algorithm minimizes the total squared error between the
desired signal and the output from the unknown system.

Note that the signal paths and identifications are the same whether the filter
uses RLS or LMS. The difference lies in the adapting portion.

Within limits, you can use any of the adaptive filter algorithms to solve an
adaptive filter problem by replacing the adaptive portion of the application
with a new algorithm.

Examples of the sign variants of the LMS algorithms demonstrated this
feature to demonstrate the differences between the sign-data, sign-error, and
sign-sign variations of the LMS algorithm.
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One interesting input option that applies to RLS algorithms is not present
in the LMS processes — a forgetting factor, λ, that determines how the
algorithm treats past data input to the algorithm.

When the LMS algorithm looks at the error to minimize, it considers only the
current error value. In the RLS method, the error considered is the total error
from the beginning to the current data point.

Said another way, the RLS algorithm has infinite memory — all error data is
given the same consideration in the total error. In cases where the error value
might come from a spurious input data point or points, the forgetting factor
lets the RLS algorithm reduce the value of older error data by multiplying
the old data by the forgetting factor.

Since 0 ≤λ< 1, applying the factor is equivalent to weighting the older error.
When λ = 1, all previous error is considered of equal weight in the total error.

As λ approaches zero, the past errors play a smaller role in the total. For
example, when λ = 0.9, the RLS algorithm multiplies an error value from 50
samples in the past by an attenuation factor of 0.950 = 5.15 x 10-3, considerably
deemphasizing the influence of the past error on the current total error.

adaptfilt.rls Example — Inverse System Identification
Rather than use a system identification application to demonstrate the RLS
adaptive algorithm, or a noise cancellation model, this example use the
inverse system identification model shown in here.
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Cascading the adaptive filter with the unknown filter causes the adaptive
filter to converge to a solution that is the inverse of the unknown system.

If the transfer function of the unknown is H(z) and the adaptive filter
transfer function is G(z), the error measured between the desired signal
and the signal from the cascaded system reaches its minimum when the
product of H(z) and G(z) is 1, G(z)*H(z) = 1. For this relation to be true,
G(z) must equal 1/H(z), the inverse of the transfer function of the unknown
system.

To demonstrate that this is true, create a signal to input to the cascaded
filter pair.

x = randn(1,3000);

In the cascaded filters case, the unknown filter results in a delay in the signal
arriving at the summation point after both filters. To prevent the adaptive
filter from trying to adapt to a signal it has not yet seen (equivalent to
predicting the future), delay the desired signal by 32 samples, the order of
the unknown system.

Generally, you do not know the order of the system you are trying to identify.
In that case, delay the desired signal by the number of samples equal to half
the order of the adaptive filter. Delaying the input requires prepending 12
zero-values samples to x.

delay = zeros(1,12);
d = [delay x(1:2988)]; % Concatenate the delay and the signal.

You have to keep the desired signal vector d the same length as x, hence
adjust the signal element count to allow for the delay samples.

Although not generally true, for this example you know the order of the
unknown filter, so you add a delay equal to the order of the unknown filter.

For the unknown system, use a lowpass, 12th-order FIR filter.

ufilt = fir1(12,0.55,'low');

Filtering x provides the input data signal for the adaptive algorithm function.
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xdata = filter(ufilt,1,x);

To set the input argument values for the adaptfilt.rls object, use the
constructor adaptfilt.rls, providing the needed arguments l, lambda, and
invcov.

For more information about the input conditions to prepare the RLS algorithm
object, refer to adaptfilt.rls in the reference section of this user’s guide.

p0 = 2*eye(13);
lambda = 0.99;
ha = adaptfilt.rls(13,lambda,p0);

Most of the process to this point is the same as the preceding examples.
However, since this example seeks to develop an inverse solution, you need to
be careful about which signal carries the data and which is the desired signal.

Earlier examples of adaptive filters use the filtered noise as the desired
signal. In this case, the filtered noise (xdata) carries the unknown system
information. With Gaussian distribution and variance of 1, the unfiltered
noise d is the desired signal. The code to run this adaptive filter example is

[y,e] = filter(ha,xdata,d);

where y returns the coefficients of the adapted filter and e contains the error
signal as the filter adapts to find the inverse of the unknown system. You can
review the returned elements of the adapted filter in the properties of ha.

The next figure presents the results of the adaptation. In the figure, the
magnitude response curves for the unknown and adapted filters show. As a
reminder, the unknown filter was a lowpass filter with cutoff at 0.55, on the
normalized frequency scale from 0 to 1.
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Comparing the Inverse Filter to the Unknown System 

Inverse Filter
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Viewed alone (refer to the following figure), the inverse system looks like a
fair compensator for the unknown lowpass filter — a high pass filter with
linear phase.
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6

Using Integers and FIR
Filters with Filter Design
Toolbox

Using integers when filtering with FIR filters can make it easier to work with
certain classes of hardware, such as FPGA and ASIC processors. In some
cases, it is convenient to work directly with integers when designing your
filter. This chapter explores a few of the issues that commonly arise when
using integers with FIR filters.

• “Review of Fixed-Point Numbers” on page 6-2

• “Integers and Fixed-Point Filters” on page 6-5

• “Using the set2int Method” on page 6-17
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Review of Fixed-Point Numbers

Terminology of Fixed-Point Numbers
Filter Design Toolbox assumes fixed-point quantities are represented in
two’s complement format, and are described using the WordLength and
FracLength parameters. It is common to represent fractional quantities of
WordLength 16 with the leftmost bit representing the sign and the remaining
bits representing the fraction to the right of the binary point. Often the
FracLength is thought of as the number of bits to the right of the binary point.
However, there is a problem with this interpretation when the FracLength is
larger than the WordLength, or when the FracLength is negative.

To work around these cases, you can use the following interpretation of a
fixed-point quantity:

The register has a WordLength of B, or in other words it has B bits. The bits
are numbered from left to right from 0 to B-1. The most significant bit (MSB)

is the leftmost bit, bB−1 . The least significant bit is the right-most bit, b0 .
You can think of the FracLength as a quantity specifying how to interpret the
bits stored and resolve the value they represent. The value represented by the
bits is determined by assigning a weight to each bit:

In this figure, L is the integer FracLength. It can assume any value,
depending on the quantization step size. L is necessary to interpret the value
that the bits represent. This value is given by the equation
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The value 2−L is the smallest possible difference between two numbers
represented in this format, otherwise known as the quantization step. In
this way, it is preferable to think of the FracLength as the negative of
the exponent used to weigh the right-most, or least-significant, bit of the
fixed-point number.

To reduce the number of bits used to represent a given quantity, you can
discard the least-significant bits. This method minimizes the quantization
error since the bits you are removing carry the least weight. For instance, the
following figure illustrates reducing the number of bits from 4 to 2:

This means that the FracLength has changed from L to L – 2.

You can think of integers as being represented with a FracLength of L = 0, so

that the quantization step becomes 2 10 = .

Suppose B = 16 and L = 0. Then the numbers that can be represented are the

integers { , ,..., , , ..., , }− − −32768 32767 1 0 1 32766 32767 .

If you need to quantize these numbers to use only 8 bits to represent
them, you will want to discard the LSBs as mentioned above, so that B=8
and L = 0–8 = –8. The increments, or quantization step then becomes

2 2 2568 8− − = =( ) . So you will still have the same range of values, but
with less precision, and the numbers that can be represented become

{ , ,..., , , ,... , }− − −32768 32512 256 0 256 32256 32512 .
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With this quantization the largest possible error becomes about 256/2 when
rounding to the nearest, with a special case for 32767.
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Integers and Fixed-Point Filters
This section provides an example of how you can create a filter with integer
coefficients. In this example, a raised-cosine filter with floating-point
coefficients is created, and the filter coefficients are then converted to integers.

Example Filter Coefficients
To illustrate the concepts of using integers with fixed-point filters, this
example will use a raised-cosine filter:

b = firrcos(100, .25, .25, 2, 'rolloff', 'sqrt');

The coefficients of b are normalized so that the passband gain is equal to 1,
and are all smaller than 1. In order to make them integers, they will need to
be scaled. If you wanted to scale them to use 18 bits for each coefficient, the
range of possible values for the coefficients becomes:

[ , ] [ , ]− − == −−2 2 1 131072 13107117 17

Because the largest coefficient of b is positive, it will need to be scaled as close
as possible to 131071 (without overflowing) in order to minimize quantization
error. You can determine the exponent of the scale factor by executing:

B = 18; % Number of bits

L = floor(log2((2^(B-1)-1)/max(b))); % Round towards zero to avoid overflow

bsc = b*2^L;

Alternatively, you can use the fixed-point numbers autoscaling tool as follows:

bq = fi(b, true, B); % signed = true, B = 18 bits
L = bq.FractionLength;

It is a coincidence that B and L are both 18 in this case, because of the value
of the largest coefficient of b. If, for example, the maximum value of b were
0.124, L would be 20 while B (the number of bits) would remain 18.

Building the FIR Filter
First create the filter using the direct form, tapped delay line structure:
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h = dfilt.dffir(bsc);

In order to set the required parameters, the arithmetic must be set to
fixed-point:

h.Arithmetic = 'fixed';
h.CoeffWordLength = 18;

You can check that the coefficients of h are all integers:

all(h.Numerator == round(h.Numerator))

ans =

1

Now you can examine the magnitude response of the filter using fvtool:

fvtool(h, 'Color', 'white')

This shows a large gain of 108 dB in the passband, which is due to the large
values of the coefficients— this will cause the output of the filter to be much
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larger than the input. A method of addressing this will be discussed in the
following sections.

Setting Filter Parameters to Work with Integers
You will need to set the input parameters of your filter to appropriate values
for working with integers. For example, if the input to the filter is from a A/D
converter with 12 bit resolution, you should set the input as follows:

h.InputWordLength = 12;
h.InputFracLength = 0;

The info method returns a summary of the filter settings.

info(h)

Discrete-Time FIR Filter (real)

-------------------------------

Filter Structure : Direct-Form FIR

Filter Length : 101

Stable : Yes

Linear Phase : Yes (Type 1)

Arithmetic : fixed

Numerator : s18,0 -> [-131072 131072)

Input : s12,0 -> [-2048 2048)

Filter Internals : Full Precision

Output : s31,0 -> [-1073741824 1073741824) (auto determined)

Product : s29,0 -> [-268435456 268435456) (auto determined)

Accumulator : s31,0 -> [-1073741824 1073741824) (auto determined)

Round Mode : No rounding

Overflow Mode : No overflow

In this case, all the fractional lengths are now set to zero, meaning that the
filter h is set up to handle integers.

Creating a Test Signal for the Filter
You can generate an input signal for the filter by quantizing to 12 bits using
the autoscaling feature, or you can follow the same procedure that was used
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for the coefficients, discussed previously. In this example, create a signal
with two sinusoids:

n = 0:999;
f1 = 0.1*pi; % Normalized frequency of first sinusoid
f2 = 0.8*pi; % Normalized frequency of second sinusoid
x = 0.9*sin(0.1*pi*n) + 0.9*sin(0.8*pi*n);
xq = fi(x, true, 12); % signed = true, B = 12
xsc = fi(xq.int, true, 12, 0);

Filtering the Test Signal
To filter the input signal generated above, enter the following:

ysc = filter(h, xsc);

Here ysc is a full precision output, meaning that no bits have been discarded
in the computation. This makes ysc the best possible output you can achieve
given the 12–bit input and the 18–bit coefficients. This can be verified by
filtering using double-precision floating-point and comparing the results of
the two filtering operations:

hd = double(h);
xd = double(xsc);
yd = filter(hd, xd);
norm(yd-double(ysc))

ans =

0

Now you can examine the output compared to the input. This example is
plotting only the last few samples to minimize the effect of transients:

idx = 800:950;
xscext = double(xsc(idx)');
gd = grpdelay(h, [f1 f2]);
yidx = idx + gd(1);
yscext = double(ysc(yidx)');
stem(n(idx)', [xscext, yscext]);
axis([800 950 -2.5e8 2.5e8]);
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legend('input', 'output');
set(gcf, 'color', 'white');

It is difficult to compare the two signals in this figure because of the large
difference in scales. This is due to the large gain of the filter, so you will
need to compensate for the filter gain:

stem(n(idx)', [2^18*xscext, yscext]);
axis([800 950 -5e8 5e8]);
legend('scaled input', 'output');
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You can see how the signals compare much more easily once the scaling has
been done, as seen in the above figure.

Truncating the Output WordLength
If you examine the output wordlength,

ysc.WordLength

ans =

31

you will notice that the number of bits in the output is considerably greater
than in the input. Because such growth in the number of bits representing
the data may not be desirable, you may need to truncate the wordlength of
the output. As discussed in “Terminology of Fixed-Point Numbers” on page
6-2the best way to do this is to discard the least significant bits, in order
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to minimize error. However, if you know there are unused high order bits,
you should discard those bits as well.

To determine if there are unused most significant bits (MSBs), you can look at
where the growth in WordLength arises in the computation. In this case, the
bit growth occurs to accommodate the results of adding products of the input
(12 bits) and the coefficients (18 bits). Each of these products is 29 bits long
(you can verify this using info(h)). The bit growth due to the accumulation of
the product depends on the filter length and the coefficient values- however,
this is a worst-case determination in the sense that no assumption on the
input signal is made besides, and as a result there may be unused MSBs. You
will have to be careful though, as MSBs that are deemed unused incorrectly
will cause overflows.

Suppose you want to keep 16 bits for the output. In this case, there is no
bit-growth due to the additions, so the output bit setting will be 16 for the
wordlength and –14 for the fraction length.

Since the filtering has already been done, you can discard some bits from ysc:

yout = fi(ysc, true, 16, -14);

Alternatively, you can set the filter output bit lengths directly (this is useful if
you plan on filtering many signals):

specifyall(h);
h.OutputWordLength = 16;
h.OutputFracLength = -14;
yout2 = filter(h, xsc);

You can verify that the results are the same either way:

norm(double(yout) - double(yout2))

ans =

0

However, if you compare this to the full precision output, you will notice that
there is rounding error due to the discarded bits:
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norm(double(yout)-double(ysc))

ans =

1.446323386867543e+005

In this case the differences are hard to spot when plotting the data, as seen
below:

stem(n(yidx), [double(yout(yidx)'), double(ysc(yidx)')]);
axis([850 950 -2.5e8 2.5e8]);
legend('Scaled Input', 'Output');
set(gcf, 'color', 'white');

Scaling the Output
Because the filter in this example has such a large gain, the output is at a
different scale than the input. This scaling is purely theoretical however,
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and you can scale the data however you like. In this case, you have 16 bits
for the output, but you can attach whatever scaling you choose. It would
be natural to reinterpret the output to have a weight of 2^0 (or L = 0) for
the LSB. This is equivalent to scaling the output signal down by a factor of
2^(-14). However, there is no computation or rounding error involved. You
can do this by executing the following:

yri = fi(yout.int, true, 16, 0);
stem(n(idx)', [xscext, double(yri(yidx)')]);
axis([800 950 -1.5e4 1.5e4]);
legend('input', 'rescaled output');

This plot shows that the output is still larger than the input. If you had done
the filtering in double-precision floating-point, this would not be the case—
because here more bits are being used for the output than for the input, so the
MSBs are weighted differently. You can see this another way by looking at
the magnitude response of the scaled filter:
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[H,w] = freqz(h);
plot(w/pi, 20*log10(2^(-14)*abs(H)));

This plot shows that the passband gain is still above 0 dB.

To put the input and output on the same scale, the MSBs must be weighted
equally. The input MSB has a weight of 2^11, whereas the scaled output
MSB has a weight of 2^(29–14) = 2^15. You need to give the output MSB
a weight of 2^11 as follows:

yf = fi(zeros(size(yri)), true, 16, 4);
yf.bin = yri.bin;
stem(n(idx)', [xscext, double(yf(yidx)')]);
legend('input', 'rescaled output');
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This operation is equivalent to scaling the filter gain down by 2^(-18).

[H,w] = freqz(h);
plot(w/pi, 20*log10(2^(-18)*abs(H)));
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The above plot shows a 0 dB gain in the passband, as desired.

With this final version of the output, yf is no longer an integer. However this
is only due to the interpretation- the integers represented by the bits in yf
are identical to the ones represented by the bits in yri. You can verify this
by comparing them:

max(abs(yf.int - yri.int))

ans =

0
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Using the set2int Method

In this section...

“Setting Filter Parameters to Work with Integers” on page 6-17

“Reinterpreting the Output” on page 6-18

Setting Filter Parameters to Work with Integers
The set2int method provides a convenient way of setting filter parameters to
work with integers. The method works by scaling the coefficients to integer
numbers, and setting the coefficients and input fraction length to zero. This
makes it possible for you to use floating-point coefficients directly.

h = dfilt.dffir(b);
h.Arithmetic = 'fixed';

The coefficients are represented with 18 bits and the input signal is
represented with 12 bits:

g = set2int(h, 18, 12);
g_dB = 20*log10(g)

g_dB =

1.083707984390332e+002

The set2int method returns the gain of the filter by scaling the coefficients
to integers, so the gain is always a power of 2. You can verify that the gain we
get here is consistent with the gain of the filter previously. Now you can also
check that the filter h is set up properly to work with integers:

info(h)

Discrete-Time FIR Filter (real)

-------------------------------

Filter Structure : Direct-Form FIR

Filter Length : 101

Stable : Yes

Linear Phase : Yes (Type 1)

6-17



6 Using Integers and FIR Filters with Filter Design Toolbox

Arithmetic : fixed

Numerator : s18,0 -> [-131072 131072)

Input : s12,0 -> [-2048 2048)

Filter Internals : Full Precision

Output : s31,0 -> [-1073741824 1073741824) (auto determined)

Product : s29,0 -> [-268435456 268435456) (auto determined)

Accumulator: s31,0 -> [-1073741824 1073741824) (auto determined)

Round Mode : No rounding

Overflow Mode : No overflow

Here you can see that all fractional lengths are now set to zero, so this filter is
set up properly for working with integers.

Reinterpreting the Output
You can compare the output to the double-precision floating-point reference
output, and verify that the computation done by the filter h is done in full
precision.

yint = filter(h, xsc);
norm(yd - double(yint))

ans =

0

You can then truncate the output to only 16 bits:

yout = fi(yint, true, 16);
stem(n(yidx), [xscext, double(yout(yidx)')]);
axis([850 950 -2.5e8 2.5e8]);
legend('input', 'output');
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Once again, the plot shows that the input and output are at different scales.
In order to scale the output so that the signals can be compared more easily
in a plot, you will need to weigh the MSBs appropriately. You can compute
the new fraction length using the gain of the filter when the coefficients were
integer numbers:

WL = yout.WordLength;
FL = yout.FractionLength + log2(g);
yf2 = fi(zeros(size(yout)), true, WL, FL);
yf2.bin = yout.bin;

stem(n(idx)', [xscext, double(yf2(yidx)')]);
axis([800 950 -2e3 2e3]);
legend('input', 'rescaled output');
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This final plot shows the filtered data re-scaled to match the input scale.
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Using FDATool
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on page 4-18
“Example — Noise Method Applied to a Filter” on page 4-22
“Example — Scale an SOS Filter” on page 4-30
“Example — Reorder an SOS Filter” on page 4-39
“Example — View the Sections of SOS Filters” on page 4-46
“Example — Export Coefficients or Objects to the Workspace” on page 4-52
“Example — Exporting as a Text File” on page 4-53
“Example — Exporting as a MAT-File” on page 4-54
“Example — Import XILINX .COE Files” on page 4-55
“Example — Design a Fractional Rate Convertor” on page 4-73
“Example — Design a CIC Decimator for 8 Bit Input/Output Data” on
page 4-76
“Example — Realize a Filter Using FDATool” on page 4-85

Adaptive Filters
“Examples of Adaptive Filters That Use LMS Algorithms” on page 5-15
“Example of Adaptive Filter That Uses RLS Algorithm” on page 5-36
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IndexA
adaptfilt object

apply to data 5-14
adaptive filter object 5-14

See also adaptfilt object

C
changing quantized filter properties in

FDATool 4-18
coefficients

exporting 4-80
context-sensitive help 4-88
controls

FDATool 4-8
converting filter structures in FDATool 4-26

D
design methods 1-6

customize 1-8
designing fixed-point multirate filters 4-78
designing multirate filters 4-78

E
exporting individual phase coefficients of a

polyphase filter 4-80
exporting quantized filters in FDATool 4-52

F
FDATool

about 4-1
about importing and exporting filters 4-50
about quantization mode 4-6
apply option 4-8
changing quantized filter properties 4-18
context-sensitive help 4-88
controls 4-8
convert structure option 4-26

converting filter structures 4-26
exporting quantized filters 4-52
frequency point to transform 4-61
getting help 4-88
import filter dialog box 4-51
importable filter structures 4-50
importing filters 4-51
original filter type 4-57
quantized filter properties 4-9
quantizing filters 4-9
quantizing reference filters 4-18
set quantization parameters dialog 4-9
setting properties 4-9
specify desired frequency location 4-62
switching to quantization mode 4-6
transform filters in FDATool 4-62
transformed filter type 4-61
user options 4-8

filter algorithm 1-6
choosing 1-6

filter data 1-10
filter design

adaptive 5-1
customize algorithm 1-8
filter analysis 1-9
Filter Object 1-8
flow chart

flow diagram 1-2
multirate filters in FDATool 4-67
process 1-2
single-rate filters in FDATool 4-2
specification 1-4
Specifications Object 1-4

Filter Design and Analysis Tool 4-1
See also FDATool

filter design GUI
context-sensitive help 4-88
help about 4-88

filter design parameters 1-4
filter response 1-4
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filters
exporting as MAT-file 4-54
exporting as text file 4-53
exporting from FDATool 4-52
getting filter coefficients after exporting 4-53
importing and exporting 4-50
importing into FDATool 4-51

filters, export as MAT-file 4-54
fixed-point multirate filters 4-78
frequency point to transform 4-61
function for opening FDATool 4-6

G
getting filter coefficients after exporting 4-53

I
import filter dialog box in FDATool 4-51
import filter dialog box options 4-51

discrete-time filter 4-51
frequency units 4-52

import/export filters in FDATool 4-50
importing filters 4-51
importing quantized filters in FDATool 4-51

M
multirate filters

designing 4-78

O
opening FDATool

function for 4-6

options
FDATool 4-8

original filter type 4-57

Q
quantization mode in FDATool 4-6
quantized filter properties

changing in FDATool 4-18
quantizing filters in FDATool 4-18

R
realize data 1-10

S
set quantization parameters dialog 4-9
setting filter properties in FDATool 4-9
specifying desired frequency location 4-62
starting FDATool 4-6

T
transform filter

frequency point to transform 4-61
original filter type 4-57
specify desired frequency location 4-62
transformed filter type 4-61

transformed filter type 4-61

U
using adaptfilt objects 5-14
using FDATool 4-51
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